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1 Introduction 

About this Document 
  

Scope of 
document 

This document provides detailed instructions on the management of OmniBAS 
systems, through the OmniLCT application, Release 1.1.3. 
The management capabilities of the OmniBAS LCT (OmniLCT) application 
include the configuration, monitoring and testing of any OmniBAS node that 
consists of an OmniBAS-4W subrack and the corresponding ODUs. 

  
Target 
Audience 

This document is intended for the operators that are responsible for 
commissioning OmniBAS systems, locally or remotely. The operators 
commissioning an OmniBAS system should have experience in the operation 
of radio telecommunication systems. 

  
Document 
Conventions 

This document applies the following conventions: 
• Bold fonts are used for: 
− Buttons 
− Menus and Submenus 
− Options 
− Tabs 
− Text boxes, check boxes and drop-down lists 

• Italic fonts are used for: 
− Window names 
− Tabbed sheet names 
− Values of an attribute 

  

 NOTE  A note calls your attention to important supplementary information. 
 

 

This symbol means CAUTION. The purpose of this symbol is to 
prevent you from performing an action that might result in damage of 
the equipment or loss of data. 
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About OmniLCT Application 
  

 The OmniLCT application is a robust SNMP based application designed to 
locally manage the OmniBAS system by providing a user friendly GUI. 
The following main functions are provided through OmniLCT application for 
the management of an OmniBAS system: 
• Configuration Management: 
− Monitoring and configuration of the elements of an OmniBAS Node 

(processor module, E1 tributary module, power and fan modules, modems 
and corresponding ODUs, GbE ports and E1 TDM lines) 

− Configuration and monitoring of Ethernet and PWE3 TDM traffic 
− Monitoring and configuration of PtP link 
− Monitoring and configuration of protections (modems protection – ring 

protection) concerning an OmniBAS Node. 
− Monitoring and configuration of Remote OmniBAS Nodes 
− Checking system release, modems and ODUs versions 
− System re-configuration in case of interruptions 
− Backup and restore of system configuration 

• Fault Management: 
− Displaying the active alarms and events of the system 
− Saving the active alarms and events in log files 

• Performance Management: 
− Displaying GbE ports statistic counters 
− Displaying Ethernet traffic statistic counters 
− Displaying PWE3 TDM traffic statistic counters 
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Hardware & Software Requirements 
 

Recommended 
H/W  

PC or Laptop with the following features: 
• Intel 2.6 GHz/ 2 MB L2 cache processor 
• 512 MB RAM 
• 80 GB hard disk 
• Monitor with 1280 x 800 pixels resolution 
• Display adapter 256 MB VRAM 
• CD/ DVD Rom drive 
• Ethernet network card (10/ 100BaseT or 100/ 1000BaseT) 
• Serial (DB9) and parallel (Centronics) ports 
• Mouse or pointing device 
Also, an Ethernet cable is required for connecting the PC/ Laptop with the 
OmniBAS-4W subrack. 

 
Required S/W • Microsoft® Windows XP (SP2) / 2000 

• OmniLCT application, Release 1.1.3 
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2 Getting Started 
  

 This chapter provides all necessary information before starting the configuration 
of the OmniBAS nodes. The chapter includes the following topics: 
• Installing & Launching the OmniLCT Application 
• Cabling Instructions for Connecting LCT to OmniBAS-4W 
• Establishing Connection with an OmniBAS Node 
• GUI Overview 
• Disconnecting/ Deleting an OmniBAS Node 
• Configuring the Application’s Environment 
• Creating/ Loading a Group of OmniBAS Nodes (Region) 
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2.1 Installing & Launching the OmniLCT Application 
 

Installing the 
OmniLCT 
application 

Use the CD provided by INTRACOM TELECOM to copy the OmniLCT.exe 

(  ) file to your PC/ Laptop. 

 
Launching the 
OmniLCT 
application 

To launch the OmniLCT application, in your PC/ Laptop, double-click the 

OmniLCT.exe (  ) file. The main environment of the OmniLCT application 
appears: 

 

 



OmniBAS LCT
User Manual - Edition 1.0

Chapter 2. Getting Started

8

2.2 Cabling Instructions for Connecting LCT to OmniBAS-4W

Introduction This paragraph provides the following topics for connecting an OmniBAS
system to the OmniLCT application using either an inband or outband
connection:
· Cabling connection for outband management (directly on OmniLCT)
· Cabling connection for outband management (through a DCN)
· Cabling connection for inband management

NOTE In case you want to monitor not only the local OmniBAS node but
also the associated remote nodes, you must establish an inband
connection.

Cabling
connection for
outband
management
(directly on
OmniLCT)

To carry out an outband connection of the OmniBAS-4W equipment directly on
your PC/ Laptop:
· Use an Ethernet CAT5 cable (8 wires-24 AWG)
· Connect the one end of the cable to a Fast Ethernet port (NMS 10/100 1 or

NMS 10/100 2) of the OmniBAS-4W subrack and the other end to the Ethernet
port of your PC/ Laptop.

Continued on next page
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Cabling Instructions for Connecting LCT to OmniBAS-4W,
Continued

Cabling
connection for
outband
management
(through a DCN)

To carry out an outband connection of the OmniBAS-4W equipment through an
existing LAN:
· Use an Ethernet CAT5 cable (8 wires-24 AWG)
· Connect the one end of the cable to a Fast Ethernet port (NMS 10/100 1 or

NMS 10/100 2) of the OmniBAS-4W subrack and the other end to an
available LAN port.

Cabling
connection for
inband
management

The inband management of an OmniBAS system is carried out through the GbE
port (ETH 100/1000 1 or ETH 100/1000 2) of the OmniBAS-4W subrack. For the
GbE connection, an Ethernet CAT6 cable (8 wires-24 AWG) is used.

NOTE Using inband management, you can monitor not only the local
OmniBAS node but also the associated remote nodes.
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2.3 Establishing Connection with an OmniBAS Node 
  

Introduction This paragraph provides the following two procedures for connecting the 
OmniLCT application with an OmniBAS node (locally or remotely): 
• Establishing local or remote connection by entering the IP address of the 

OmniBAS node 
• Establishing local or remote connection by using the FIND button 

   
NOTE  

When both, OmniLCT application and OmniBAS node are in the 
same subnet, you can use any of the two procedures. But, when 
OmniLCT application and OmniBAS node are in different subnets 
you can use only the first procedure. 

 
NOTE  

The default IP address of the outband management interface is 
192.168.1.100. 

 
Establishing 
local or remote 
connection by 
entering the IP 
address of the 
OmniBAS node 

To establish a local or remote connection with an OmniBAS node, proceed as 
follows: 
 

NOTE  
Alternatively, when both, OmniLCT application and OmniBAS 
node are in the same subnet, you can establish local or remote 
connection with an OmniBAS node by following the procedure 
provided in par. Establishing local or remote connection by using 
the FIND button, on page 13. 

 

Step Action 

1 Double-click the OmniLCT.exe ( ) file to launch the OmniLCT 
application. 

2 

 

After launching the application, 
right click in the blank area of the 
Management Tree, and from the 
drop-down menu, select the Add 
New System option. 

3 In the top element that appears 
(displaying 000.000.000.000), 
type the IP address of the 
OmniBAS node (e.g. 
192.168.57.8), to which the 
OmniLCT is to be connected. 
Press Enter to set.  

Continued on next page 
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Establishing Connection with an OmniBAS Node, Continued 

 
Establishing 
local or remote 
connection by 
entering the IP 
address of the 
OmniBAS node 
(continued) 

 

Step Action 
4 In the Management Tree, right click the OmniBAS IP address, and 

from the drop-down menu, select the Connect option to 
automatically build-up the OmniBAS Management Tree. 

Alternatively, you can click the  button in the Network 
Neighborhood group box of the System window.  

Continued on next page 
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Establishing Connection with an OmniBAS Node, Continued 

 
Establishing 
local or remote 
connection by 
entering the IP 
address of the 
OmniBAS node 
(continued) 

 

Step Action 
5 When the connection with the OmniBAS node has been 

established successfully, the connected node is displayed in the 
Management Tree and its characteristics appear in the System 
Characteristics group box of the OmniBAS System properties 
window: 

 
End of procedure. 

Continued on next page 
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Establishing Connection with an OmniBAS Node, Continued 

 
Establishing 
local or remote 
connection by 
using the FIND 
button 

To establish a local or remote connection with an OmniBAS node, when both 
OmniLCT application and OmniBAS-4W are in the same subnet, proceed as 
follows: 
 

Step Action 

1 Double-click the OmniLCT.exe ( ) file to launch the OmniLCT 
application. 

2 In the Management Tree click 

the  button to ping 
the network for active 
OmniBAS agents. 

3 When an OmniBAS node is 
found, the Management Tree 
displays the IP address of the 
node (e.g. 192.168.57.8). 

4 In the Management Tree, right click the OmniBAS IP address, and 
from the drop-down menu, select the Connect option to 
automatically build-up the OmniBAS Management Tree. 

 

Alternatively, you can click the  button in the Network 
Neighborhood group box of the System window.  

Continued on next page 
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Establishing Connection with an OmniBAS Node, Continued 

 
Establishing 
local or remote 
connection by 
using the FIND 
button 
(continued) 

 

Step Action 
5 When the connection with the OmniBAS node has been 

established successfully, the connected node is displayed in the 
Management Tree and its characteristics appear in the System 
Characteristics group box of the OmniBAS System properties 
window: 

 
 
End of procedure. 

 



Chapter 2. Getting Started OmniBAS LCT 
User Manual - Edition 1.0

 

  
15

 

2.4 GUI Overview 
  

Introduction The scope of this section is to get you familiar with the Graphical User 
Interface (GUI) of the OmniLCT application. 
The OmniLCT GUI consists of the following parts:  

Main Menu Toolbar

Management Tree Properties window

 
GUI Parts Reference 

Main Menu 
Toolbar 

par. Main Menu & Toolbar (page 16) 

Management 
Tree 

• par. Elements Representation in Management Tree (page 17) 
• par. Drop-Down Menu & Toolbar of Management Tree (page 18) 

Properties 
window par. Properties Window (page 19) 
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Main Menu & Toolbar 
 

 The following table provides a short description of the Main Menu and the 
Toolbar of the OmniLCT application: 

  
Menu Sub-Menu Toolbar 

button 
Description Reference 

Open Region  
To load a group (region) of 
OmniBAS nodes. 

Save Region  
To create/ save a group 
(region) of OmniBAS nodes.

See par. Creating/ Loading 
a Group of OmniBAS 
Nodes (Region) (page 24) 

Cancel − To cancel an action that is 
running. − 

Exit − To terminate the OmniLCT 
application. − 

Fi
le

 

Shut Down 
Now − 

To shut down the OmniLCT 
application. Use the shut 
down option only if the 
system does not respond.

− 

Properties  
To display the OmniBAS 
System properties window. − 

Performance 
Monitor  

To display the Performance 
Monitor window. 

See Ch. 6. Monitoring the 
Performance of an 
OmniBAS Node W

in
do

w
s 

Management 
Tree − To appear/ disappear the 

Management Tree. − 

V
ie

w
 

Message 
Trace − To display the Message 

Trace window. 
See par. Message Traces 
(page 133) 

Connection 
List 

To display the Connections 
List window. 

Connection 
Wizard 

To open the Connection 
Setup Wizard. 

See par. Creating PWE3 
TDM Connections(page 74)

Environment 
Options − To display the Environment 

Options window. 

See par. Configuring the 
Application’s Environment 
(page 21) 

To
ol

s 

Alarm & Event 
List  

To display the Alarms & 
Events Report window. 

See par. Alarms & Events 
Report (page 131) 

H
el

p 

About − To check the release of the 
OmniLCT application. − 
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Elements Representation in Management Tree

Management
Tree –
Elements
Representation

The elements that constitute a connected OmniBAS node are displayed in the
Management Tree. A short description of the OmniBAS Management Tree is
shown in the following schematic:

Modems slot
numbering

An OmniBAS-4W subrack can be equipped with up to four modems. The
following figure shows the slot numbering of the OmniBAS-4W modems.

An OmniBAS modem is depicted in the Management Tree as
PtP slot x, where x = 1, 2, 3, 4 (e.g. ).
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Drop-Down Menu & Toolbar of Management Tree 
 

Management 
Tree – drop 
down menu 

When you right click on an OmniBAS node (or on the blank area) of the 
Management Tree window, a drop-down menu appears.  

 
The drop-down menu of the Management Tree window provides the following 
options: 

Option Description 
Add New System To add a new OmniBAS node in the Management Tree (1). 
Delete System To delete an OmniBAS node from the Management Tree. 

An OmniBAS node can be deleted from the Management 
Tree only when it is disconnected (2). 

Connect To establish a connection with an OmniBAS node (1). 
Disconnect To disconnect an OmniBAS node (2). 
Rename To rename an OmniBAS node (1). 

 
 

  
Management 
Tree – Toolbar 

The toolbar of the Management Tree includes the following buttons: 

Button Description 

 Click this button to ping the network for active OmniBAS agents (1).

 When clicking this button the following Legend box appears. 

 The Legend box provides the 
explanation of the icons existing at 
the left side of some elements  
(e.g. ) for indicating 
their current status. 

 
 

   

                                                 
(1)  As described in par. Establishing Connection with an OmniBAS Node, on page 10. 
(2)  As described in par. Disconnecting/ Deleting an OmniBAS Node, on page 20. 
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Properties Window 
 

Properties 
window 

When you select an OmniBAS element in the Management Tree, the 
corresponding Properties window appears. 
For example, the following screenshot shows the Properties window (naming 
Management Control Properties) that appears when you select the Control 
element: 

 
The Properties window contains the toolbar, the messages area at the bottom 
of the window (that displays the most current SNMP message (trace)) and the 
properties and settings related to the selected element. 
Through a Properties window, you can: 
• Configure the selected element 
• Monitor the status of the selected element 

 
Properties 
window toolbar 
- Most common 
buttons 

Depending on the selected element, the buttons of the toolbar can vary. The 
most common buttons of a Properties window toolbar are described in the 
following table: 

Button Description 

 To retrieve the current information regarding the selected element. 

 
When you change a configuration setting of the selected element, 
then, click this button to apply the new value.  
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2.5 Disconnecting/ Deleting an OmniBAS Node 
   

Disconnecting 
an OmniBAS 
node 

To disconnect an OmniBAS node from the OmniLCT application, proceed as 
follows: 
 

Step Action 
1 In the Management Tree, select 

the top element (e.g. 
192.168.57.14) corresponding to 
the OmniBAS node you want to 
disconnect, right click and from 
the drop-down menu select the 
Disconnect option. 

2 The OmniBAS node is 
disconnected from the OmniLCT 
application. 

  
End of procedure. 

 
Deleting an 
OmniBAS node 

To remove an OmniBAS node from the Management Tree, proceed as follows: 
 

Step Action 
1 Disconnect the OmniBAS node as described in previous par. 

Disconnecting an OmniBAS node. 
2 Select the top element (e.g. 

192.168.57.14) corresponding to 
the OmniBAS node you want to 
remove, right click and from the 
drop-down menu select the 
Delete System option. 

3 The selected OmniBAS node is 
removed from the Management 
Tree. 

  
End of procedure. 
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2.6 Configuring the Application’s Environment 
  

 This section provides the following procedures to configure the application’s 
environment: 
• Configuring the Environment Parameters (system responses, requests 

timeout, etc.) 
• Viewing the Registered IP Addresses 

Use this procedure to view all registered IP addresses and/ or to register the 
IP address of your PC/ Laptop. 

 
 
Configuring the Environment Parameters 

 
 To configure the application’s operating environment, proceed as follows: 
 

Step Action 
1 On the Toolbar, click Tools > Environment Options. 
2 In the window that appears, ensure that the Parameters tab is 

displayed – if not, select it: 

Continued on next page 
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Configuring the Environment Parameters, Continued 

  
Step Action 

3 In the System Parameters group box, define the following 
parameters: 

Parameter Description 
Request timeout 
(ms) 

The time (in ms) the application will wait for an 
answer from the supervised system, since the 
instance of a request. The default value is 10000. 

Retransmissions The maximum number of retries before the request 
is considered as unanswered. The default value is 3.

List Bound The maximum number of logged alarms/ messages 
to display in the relevant report. When this number 
is reached, the report is cleared and new alarms/ 
messages can be logged. The default value is 5000.

 
 

4 In the Application Environment group box, select the appropriate 
check boxes: 

Check Box Select if 
Show inaccessible 
components as 
disabled 

You want the application to display the inaccessible 
components as disabled (default setting = selected).

Show wait / error 
dialogs 

You want the application to display dialogs relevant 
to progress or errors regarding the various 
executable tasks (default setting = clear). 

Apply protection 
(requires update) 

You need protection against accidental misuse of 

the  button (default setting = selected). 
 
 

 
End of procedure. 
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Viewing the Registered IP Addresses 
 

 To view all registered IP addresses and/ or register the IP address of your PC 
/ Laptop, proceed as follows: 

 
Step Action 

1 On the Toolbar, click Tools > Environment Options. 
2 In the window that appears, click the Registration tab. 

 
3 Click  to display all the registered IP addresses. 

 
4 If you want to register the IP address of your PC / Laptop (if not yet 

listed), click  and then click . 
5 If you want to remove an IP address from the list, first select the IP 

address, click  and then click . The selected IP 
address is now removed from the list. 

 
End of procedure. 
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2.7 Creating/ Loading a Group of OmniBAS Nodes (Region) 
  

Introduction This paragraph describes how to create, save and load a group (region) of 
OmniBAS nodes featuring common geographical, conceptual, etc. 
characteristics.  

  
NOTE  

When you log in to the OmniLCT application, the region file recently 
used is automatically loaded in the Management Tree. 

 
Creating/ 
saving a region 

To create/ save a group (region) of OmniBAS nodes, proceed as follows: 
 

Step Action 
1 

 

Load the OmniBAS nodes you want to 
group (e.g.192.168.57.9 OmniBAS 
and 192.168.57.11 OmniBAS). 
 

2 
On the Main Menu, select File > Save Region (or click , on 
the Toolbar).   

3 

 

In the Save OmniLCT 
Region File window that 
appears, save the region 
in .ini format (e.g. 
Region A.ini) and click 
Save. 
The region is created/ 
saved (e.g. Region A 
including the 
192.168.57.9 OmniBAS 
and 192.168.57.11 
OmniBAS nodes). 

 
End of procedure.  

 
Loading a 
region 

To load a group (region) of OmniBAS nodes, select File > Open Region on 

the Main Menu (or click , on the Toolbar). The selected group (region) 
of the OmniBAS nodes appears in the Management Tree. 
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3 Configuring OmniBAS System 
  

 This chapter includes the following topics through which all necessary 
procedures to configure an OmniBAS system are provided: 
• Configuring a Radio Link 
• Configuring Ethernet Traffic 
• Configuring PWE3 TDM Connections 
• Setting Static MAC Addresses 
• Setting/ Monitoring System Synchronization 

 
  
3.1 Configuring a Radio Link 

  
 This section provides the following step-by-step procedures to configure an 

OmniBAS radio link.  
 

 # Procedure Page 
1 Configuring the Protection of an OmniBAS Node  26 
2 Configuring an ODU 30 
3 Setting the Channel Bandwidth of a Link  36 
4 Enabling Adaptive Coding & Modulation (ACM) 39 
5 Setting Manual Modulation Mode 42 
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Configuring the Protection of an OmniBAS Node

Introduction An OmniBAS-4W can be equipped with up to four modems. The modems
located at slots 1 and 3 constitute a protection pair (Pair 1-3). Also, the
modems located at slots 2 and 4 constitute the second protection pair
(Pair 2-4) of the subrack.

A protection pair is defined as Standalone (when both modems work in
standalone mode) or Protected (when the one modem is in working mode and
the other in standby).
This paragraph provides step-by step procedures for configuring the protection
of an OmniBAS node (i.e. for setting a modems pair to work in standalone or
protection mode).

Setting a
standalone pair

To set the modems pair 1-3 in standalone mode, proceed as follows:

NOTE The following procedure describes how to set the modems Pair 1-3 in
standalone mode. Follow a same procedure for the Pair 2-4.

Step Action
1 In the Management Tree, expand the

OmniBAS node you want and select the
Control element.

2 In the Management Control Properties window that appears, click the
 button to view the current properties of the Control element.

Continued on next page
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Configuring the Protection of an OmniBAS Node, Continued 

  
Setting a standalone pair (continued) 
 

Step Action 
3 In the System group box, click the Pair 1-3 drop-down list and select 

Standalone. 

 
4 Click the corresponding  button to apply the setting. 

 
End of procedure. 

  
Setting a 
protected pair 

To set the modems pair 1-3 in protected mode, proceed as follows: 

 

NOTE  
The following procedure describes how to set the modems Pair 1-3 
in protected mode. Follow a same procedure for the Pair 2-4. 

 

Step Action 
1 In the Management Tree, expand the 

OmniBAS node you want and select the 
Control element. 

2 In the Management Control Properties window that appears, click the 
 button to view the current properties of the Control element.  

Continued on next page 
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Configuring the Protection of an OmniBAS Node, Continued 

  
Setting a protected pair (continued) 
 

Step Action 
3 In the System group box, click the Pair 1-3 drop-down list and select 

Protected. Click the corresponding  button to apply the setting. 

 
4 In the Actions group box, click the  button. The PtP 

Modem Protection window that appears, click the  button to 
view the current protection settings of the selected OmniBAS node. 

 In the Modem Pair 1-3 
group box: 
• The Modem Protection 

Status 1 field shows the 
current protection status 
(e.g. Working) of the 
modem located at slot 1 
(PTP slot 1).  

• The Modem Protection 
Status 3 field shows the 
current protection status 
(e.g. Standby) of the 
modem located at slot 3 
(PTP slot 3). 

Continued on next page 
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Configuring the Protection of an OmniBAS Node, Continued 

  
Setting a protected pair (continued) 

 
Step Action 

5 • Select the Revert To Preferred Modem check box, in case you want, 
the protection mechanism to revert to the preferred working modem in 
case it recovers from a failure. By default, this check box is selected. 

• Click the  button to apply the setting. 
6 • For setting: 

• 1+1 FD (Frequency Diversity) protection, select the Diversity 
Enabled check box. 

• 1+1 HSB (Hot Stand-By) protection, leave the Diversity Enabled 
check box, unselected. 

• Click the  button to apply the setting. 
7 • If you want to switch the 

modems (i.e. the working 
modem to enter standby 
mode and vice-versa), 
select the modem you 
want to enter working 
mode (e.g. select 
Modem 3) from the 
Preferred Working 
Modem drop-down list. 

• Click the  button to 
apply the modems 
switching. 

 

 
End of procedure. 
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Configuring an ODU 
  

Introduction This paragraph describes how to: 
• Configure an ODU (Tx frequency, Tx power, etc.) 
• Set the alarm thresholds (RSSI and temperature upper threshold) of an ODU 
• Upgrade the firmware of an ODU 
To configure an OmniBAS radio link, perform the procedures provided in this 
paragraph to both ODUs (local and remote) of the link. 

  
Configuring 
an ODU 

To configure an ODU of an OmniBAS node, proceed as follows: 

  
Step Action 

1 

 

In the Management Tree, expand the 
Network element and click the ODU you 
want. 

2 In the PtP -ODU Management Properties window, ensure that the 
Configuration tab is displayed – if not, select it.  

In the Configuration tabbed sheet, click the  button to view the 
current properties of the ODU. 

 

Continued on next page 
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Configuring an ODU, Continued 

  
Configuring an ODU (continued) 
 

Step Action 
3 Consult the following table to define the parameters of the ODU: 

Attribute Description 
Set Tx 
Frequency 

In the Set Tx Frequency text box enter the Tx frequency 
value (in kHz) (1). 

Set Tx 
Power 

In the Set Tx Power text box enter the Tx power value (in 
dBm) (1).  

Mute From the Mute drop-down list select mute: 
• ON, to mute the ODU. Muting an ODU results in 

transmission interruption of the ODU. 
• OFF, to unmute the ODU. 

Loop From the Loop drop-down list select: 
• ON, to enable ODU loopback. 
• OFF, to disable ODU loopback. 

DC Power From the DC Power drop-down list select: 
• ON, to enable the selected ODU’s power up. 
• OFF, to enable the ODU’s power down. 

Auto Update 
Mode 

From the Auto Update Mode drop-down list select: 
• Auto, to enable the automatic upgrading of the ODU. 

The upgrading of the ODU starts automatically, when 
OmniLCT application detects that a new firmware 
should be installed. 

• Manual, to enable the manual upgrading of the 
ODU(2). 

 
NOTE  

The Update Status of the ODU (Updated, 
Needs Update or Updated Now) is displayed 
in the Status tabbed sheet (see par. 
Monitoring ODU current status, page 123). 

 

 

Be careful with the upgrading of an ODU, 
since when an ODU upgrading process is 
completed, the ODU reboots; this reboot 
process will cause link downtime. 

 
 

Continued on next page 

                                                 
(1)  You can see the upper and lower thresholds of the Tx Frequency and Tx Power in the corresponding 
fields of the Capabilities tabbed sheet. 
(2) To upgrade the firmware of an ODU manually, see par. Manual Upgrading of ODU firmware, on page 34. 
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Configuring an ODU, Continued 

  
Configuring an ODU (continued) 

 
Step Action 

4 When you finish, click the  button to apply the new settings to 
the selected ODU. 

 
End of procedure. 

 Continued on next page 
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Configuring an ODU, Continued 

  
Setting RSSI & 
Temperature 
alarm 
thresholds 

To set the RSSI and Temperature alarm thresholds of an ODU, proceed as 
follows: 
 

Step Action 
1 

 

In the Management Tree, 
expand the Network element 
and click the ODU you want. 

2 In the PtP -ODU Management Properties window, click the Alarms 
Configuration tab.  
In the Alarms Configuration tabbed sheet that appears, click the 

 button to retrieve the current alarm thresholds of the ODU. 

 
3 To set a new RSSI threshold, type the new one in the RSSI 

Threshold text box. RSSI threshold should range between  
30 dBm and 85 dBm. 

Click the  button to apply the new setting. 
4 To set a new Temperature threshold, type the new one in the 

Temperature Threshold text box. Temperature threshold should 
range between 60 ºC and 80 ºC. 

Click the  button to apply the new setting. 
  
End of procedure. 

Continued on next page 
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Configuring an ODU, Continued 

 
Manual 
Upgrading of 
ODU firmware 

To upgrade the firmware of an ODU (manually), proceed as follows: 
 

 

Be careful with the upgrading of an ODU, since when an 
ODU upgrading process is completed, the ODU reboots; 
this reboot process will cause link downtime. 

 
NOTE  

An ODU should be upgraded when the Needs Updated 
message is displayed in the Update Status field of the ODU’s 
Status tabbed sheet. (See par. Monitoring ODU current status, 
on page 123). 

 
NOTE  

Nothing is happen when you try to update an already updated 
ODU (i.e. the Updated message is displayed in the Update 
Status field of the ODU’s Status tabbed sheet. 

 
Step Action 

1 

 

In the Management Tree, expand 
the Network element and click the 
ODU you want. 
 

2 In the PtP -ODU 
Management Properties 
window, click the 
Configuration tab.  
In the Configuration tabbed 
sheet, click the  
button to view the current 
properties of the ODU. 

Continued on next page 
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Configuring an ODU, Continued 

 
Manual 
Upgrading of 
ODU firmware 
(continued) 

 

Step Action 
3 Verify that the Manual option appears in the Auto Update Mode 

drop-down list. 
To change the Auto Update Mode attribute of the ODU, see par. 
Configuring an ODU, on page 30.  

4 Click the  button to start the upgrading process.  
5 In the following confirmation message that appears, click Yes to 

continue: 

 

6 Wait for the ODU upgrading process to complete.  
When the ODU upgrade is complete, a trap is sent in the Alarms 
& Events Report window and the Updated message is displayed 
in the Update Status field of the ODU’s Status tabbed sheet(1). 

  
End of procedure. 

 

                                                 
(1) See par. Monitoring ODU current status, on page 123. 
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Setting the Channel Bandwidth of a Link 
 

Introduction To set the channel bandwidth of an OmniBAS link, you should assign the 
same channel bandwidth settings to both OmniBAS nodes (local and remote) 
of the link. 

Local OmniBAS Node
192.168.57.9

Remote OmniBAS Node
192.168.57.8

OmniLCT

PtP slot3 PtP slot3

The procedure provided below, describes how to set the channel bandwidth of 
the one edge of the OmniBAS link (e.g. to PtP Slot 3 of the Remote OmniBAS 
Node). Repeat the procedure, for the other edge of the link (e.g. to PtP Slot 3 
of the Local OmniBAS Node). 

 

 
The channel bandwidth setting must be carried out only by qualified 
personnel.  

 

 

During the channel bandwidth configuration, link downtime is 
caused. For this reason, it is recommended to start with the channel 
bandwidth configuration of the most remote node to reduce the total 
link downtime. 

Continued on next page 
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Setting the Channel Bandwidth of a Link, Continued 

 
Setting channel 
BW 

To set the channel bandwidth of the one edge of an OmniBAS link, proceed 
as follows: 

  
Step Action 

1 In the Management Tree, expand 
the Network element of the local 
or remote OmniBAS node (e.g. 
183.168.57.8) and click the 
modem corresponding to the link 
you want (e.g. PTP slot 1). 

2 In the Management PtP Modem Properties window, click the 
 button to view the current properties of the modem. 

Continued on next page 
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Setting the Channel Bandwidth of a Link, Continued 

  
Step Action 

3 In the Configuration group box, click the Bandwidth drop-down list 
and select the channel bandwidth to be associated with the selected 
modem: 7 MHz, 14 MHz, 28 MHz or 56 MHz. 

 
4 From the Profile drop-down list select one of the following profiles to 

be associated with the link: 
• Optimum Sys Gain, to enable higher gain performance (and 

hence, lower capacity) for the link  
• Optimum Capacity, to enable higher capacity performance (and 

hence, lower gain) for the link 
• Normal, to enable normal gain and capacity performance for the 

link 
5 In the Configuration group box, click the  button to apply the 

channel bandwidth settings to the selected modem of the OmniBAS 
link. 

 
End of procedure. 
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Enabling Adaptive Coding & Modulation (ACM) 
   

Introduction To enable the Adaptive Coding & Modulation (ACM) of an OmniBAS link, you 
should enable the ACM to both OmniBAS nodes (local and remote) of the link. 

Local OmniBAS Node
192.168.57.9

Remote OmniBAS Node
192.168.57.8

OmniLCT

PtP slot3 PtP slot3

 
The procedure provided below, describes how to enable the ACM to the one 
edge of the OmniBAS link (e.g. to PtP Slot 3 of the Remote OmniBAS Node). 
Repeat the procedure, for the other edge of the link (e.g. to PtP Slot 3 of the 
Local OmniBAS Node). 

  
About ACM When the Adaptive Coding & Modulation (ACM) is enabled, the modem 

automatically adjusts modulation (from 256QAM to QPSK and vice versa). 
Enabling ACM, the modem operates in the highest possible modulation, 
according to link quality metrics. This way, the critical, real-time applications 
run unaffected, independently of the weather conditions 
During stormy weather, for instance, the modem automatically reduces the 
modulation so that non real-time, data-based applications may be affected by 
throughput degradation, but real-time, high-revenue applications (such as 
real-time video and voice) will continue to run uninterrupted. 

Continued on next page 
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Enabling Adaptive Coding & Modulation (ACM), Continued 

  
Enabling ACM To enable the ACM feature of a modem, proceed as follows: 
  

Step Action 
1 In the Management Tree, expand 

the Network element of the 
OmniBAS node (e.g. 183.168.57.8) 
and click the modem you want (e.g. 
PTP slot 1). 
 

2 In the Management PtP Modem Properties window, click the  
button to view the current properties of the modem. 

Continued on next page 
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Enabling Adaptive Coding & Modulation (ACM), Continued 

  
Enabling ACM (continued) 

 
Step Action 

3 In the Modulation group box, click the ACM Mode drop-down list 
and select Automatic. 

 
4 In the Modulation group box, click the  button to apply the 

new setting to the modem. 
 

NOTE  
You do not need to reset the modem for the change to 
apply. 

 
End of procedure. 

 



OmniBAS LCT  
User Manual - Edition 1.0 

Chapter 3. Configuring OmniBAS System 

 

42 

 

Setting Manual Modulation Mode 
   

Introduction To set the manual modulation mode of an OmniBAS link, you should assign 
the same modulation settings to both OmniBAS nodes (local and remote) of 
the link. 

Local OmniBAS Node
192.168.57.9

Remote OmniBAS Node
192.168.57.8

OmniLCT

PtP slot3 PtP slot3

The procedure provided below, describes how to set the manual modulation 
mode of the one edge of the OmniBAS link (e.g. to PtP Slot 3 of the Remote 
OmniBAS Node). Repeat the procedure, for the other edge of the link (e.g. to 
PtP Slot 3 of the Local OmniBAS Node). 

 Continued on next page 



Chapter 3. Configuring OmniBAS System OmniBAS LCT 
User Manual - Edition 1.0

 

  
43

 

Setting Manual Modulation Mode, Continued 

  
Setting manual 
modulation mode 

To set the manual modulation mode of a modem, proceed as follows: 

  
Step Action 

1 In the Management Tree, expand 
the Network element of the 
OmniBAS node (e.g. 
183.168.57.8) and click the 
modem you want (e.g. PTP slot 1). 
 

2 In the Management PtP Modem Properties window, click the  
button to view the current properties of the modem. 

Continued on next page 
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Setting Manual Modulation Mode, Continued

Setting manual modulation mode (continued)

Step Action
3 In the Modulation group box, click the ACM Mode drop-down list

and select Manual.

The modem will use the modulation mode that you will assign
through the PHY Mode drop-down list.

4 Click the  button (next to the PHY Mode drop-down list).
The Modem PHY Modulation List appears displaying up to 16
physical profile entries.

Continued on next page
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Setting Manual Modulation Mode, Continued

Setting manual modulation mode (continued)

Step Action
5 Select the physical profile

entry you want, click the right
mouse button and from the
drop-down menu that appears,
click Select PHY Modulation.

6 The selected physical profile entry (and specifically, its index)
appears in the PHY Mode drop-down list.

7 In the Modulation group box, click the  button to apply the
modulation settings to the modem.

NOTE You do not need to reset the modem for the change to
apply.

End of procedure.
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3.2 Configuring Ethernet Traffic 
  

 This section provides the following step-by-step procedures to configure the 
Ethernet traffic.  

 
 # Procedure Page 
1 Setting L2 Bridging Mode 47 
2 Creating VLANs  49 
3 Setting L2 Ports 51 
4 Associating VLANs with L2 Port 56 
5 Setting Ethernet QoS 60 
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Setting L2 Bridging Mode 
 

Introduction OmniLCT application automatically creates six L2 ports for an OmniBAS node, 
two corresponding to the GbE ports (Wireline L2 ports) with index 1 and 2 and 
four corresponding to the modems (Wireless L2 ports) with index 3, 4, 5 and 6. 
The L2 ports cannot be deleted. The default VLAN of the L2 ports is the native 
VLAN (VLAN with ID=1). 
The L2 ports of an OmniBAS node must be configured to operate in C-VLAN 
mode or S-VLAN(1) mode. All L2 ports of an OmniBAS must be configured to 
operate only in one of the above modes (C-VLAN or S-VLAN). 
This paragraph describes how to set the L2 bridging mode of an OmniBAS 
node. 

  
Setting L2 
bridging mode 

To set the L2 bridging mode of an OmniBAS node, proceed as follows: 

 
Step Action 

1 In the Management Tree, expand the 
OmniBAS node you want and select the 
Control element. 

2 In the Management Control Properties window that appears, click the 
 button (located in the System group box).  

 

Continued on next page 

                                                 
(1)  Future release 
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Setting L2 Bridging Mode, Continued 

  
Setting L2 bridging mode (continued) 
 

Step Action 
3 In the L2 Properties window, click the Bridge tab to display the 

Bridge tabbed sheet.  

4 Click the  button to retrieve the current configuration of the 
L2 bridging mode. 

5 If you want to change the L2 bridging mode of the OmniBAS node: 
• From the Bridging Mode drop-down list, select C-VLAN or 

S-VLAN. 
• Click the  button to apply the selected bridging mode to all 

L2 ports of the OmiBAS node. 
 

End of procedure. 
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Creating VLANs 
  

Introduction This paragraph describes how to create VLANs in an OmniBAS node. 

  
Creating VLANs To create the VLANs of an OmniBAS node, proceed as follows: 
  

Step Action 
1 

 

In the Management Tree, expand the 
OmniBAS node you want and select 
the Control element. 

2 In the Management Control Properties window that appears, click 
the  button (located in the System group box).  

 
3 In the L2 Properties window that appears, ensure that the VLAN tab 

is displayed – if not, select it: 

 

Continued on next page 
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Creating VLANs, Continued 

  
Creating VLANs (continued) 
 

Step Action 
4 To view the list regarding all created VLANs, click the  button. In 

the VLAN List window that appears, click the  button to display 
the list of the created VLANs. 

 

 NOTE  
By default, the VLAN with ID =1 is used for the management 
VLAN. 

5 In the VLAN tabbed sheet: 
• Type the ID of the VLAN you want to create (e.g. 10) in the VLAN ID 

text box. Type a value between 2 and 4094. 
• If you want to create more than one VLAN (with contiguous ID), select 

the Up to check box and type the ID of the last VLAN you want to 
create in the corresponding text box (e.g.12 – therefore, the following 
three VLANs are requested to be created: 10, 11 and 12). 

 
6 Click the  button, to create the customer VLAN(s).  

If you want to verify the creation of the new VLAN(s), repeat step 4. 
 

NOTE  
In case you want to delete VLANs, see par. Removing VLAN(s), 
on page 139. 

 
End of procedure. 
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Setting L2 Ports 
   

Introduction This paragraph describes how to monitor the current settings of the L2 ports 
of an OmniBAS node and also how to change the settings of an L2 port. 

 
Monitoring/ 
Modifying L2 
ports 

To monitor/ change the settings of an L2 port, proceed as follows:  
 

Step Action 
1 In the Management Tree, expand 

the OmniBAS node you want and 
select the Control element. 

2 In the Management Control Properties window that appears, click 
the  button (located in the System group box).  

 
3 In the L2 Properties window, click the L2 Port tab.  

In the L2 Port tabbed sheet, click the  button.  

Continued on next page 
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Setting L2 Ports, Continued 

  
Monitoring/ Modifying L2 ports (continued) 
 

Step Action 
4 In the L2 Port List window that appears, click the  button to 

display the L2 ports of the OmniBAS node. 
The L2 ports together with their current attributes are displayed. 

5 In case you want to change the settings of an L2 port, select the L2 
port you want (e.g. Modem 4), click the right mouse button and from 
the drop-down menu select the Select L2 Port option. 

6 The selected L2 port is displayed in the L2 Port tabbed sheet. 

 

Continued on next page 
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Setting L2 Ports, Continued 

  
Monitoring/ Modifying L2 ports (continued) 
 

Step Action 
7 Click the  button to retrieve the current attributes of the 

selected L2 port. 

8 Consult the following table to modify any of the L2 port attribute: 

Attribute Description 
L2 Port Displays the selected L2 port. 
Port VLAN 
Type 

Displays the L2 bridging modes: C VLAN Port Mode or  
S VLAN Port Mode (1). 

Default 
VID 

Displays the default VLAN of the selected L2 port. This is the 
VLAN tag by which the incoming untagged frames are 
tagged and it is used for the cases where user traffic is 
untagged or priority tagged(2). 
 If you want to change the Default VID of the L2 port: 
− Click the   button. 

− In the VLAN list window that appears, click the  
button to display all created VLANs.  

− Select the VLAN you want, click the right mouse button 
and from the drop-down menu that appears select the 
Select VLAN option. 
The selected VLAN ID is displayed in the Default VID 
field. 

 
 

Continued on next page 

                                                 
(1)  Future release 
(2)  See Appendix B – 802.1Q Ethernet Frame for the description of the Ethernet MAC frame. 
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Setting L2 Ports, Continued 

  
Monitoring/ Modifying L2 ports (continued) 
 

Step Action 
8 

 

Attribute Description 
Default 
Priority 

This is the default priority applied to the incoming untagged 
packets. It can be also applied to priority tagged packets 
when the Overwrite Default Priority attribute takes Default 
Priority value. 
To change the default priority of the selected L2 port, select 
a new one (0 (lowest priority) to 7 (highest priority), with 
default value = 0) from the Default Priority drop-down list. 

Port 
Ingress 
Check 

From the Port Ingress Check drop-down list, select: 
• Enable: If a packet arrives to this L2 port and its VLAN 

does not belong to the port tagged list (list of VLANs 
defined for this port), it is dropped. 

• Disable: All packets arriving to this L2 port are accepted. 
Acceptable 
Frame 
Type 

From the Acceptable Frame Type drop-down list, select(2):
• Untagged Only: L2 port accepts only untagged frames 

and priority tagged frames 
• Tagged Only: L2 port accepts only tagged frames 
• Tagged and Untagged: L2 port accepts all frames, tagged 

and untagged 
• Accept None: L2 port drops all frames (tagged and 

untagged) 
Overwrite 
Default 
Priority 

From the Overwrite Default Priority drop-down list, select 
the priority type for the selected L2 port: Default Priority or 
Incoming C Tag Priority.  
Note that this field is applicable only when S-VLAN mode(1) 
is selected. 

Port Type Displays the type of the selected L2 port (Ethernet). 
 
 

9 If you change the attributes of the L2 port, click the  button to 
apply the changes. 

 

NOTE  
To enable the priority mapping feature, see par. Setting Ethernet QoS, 
on page 60. 

 

 NOTE  
Through the L2 Port tabbed sheet (of the L2 Properties window), you 
can select to monitor the statistics of an L2 port. For the procedure 
concerning the monitoring of the L2 ports statistics, see par. 
Monitoring the L2 Ports Performance , on page 162. 

 

End of procedure. 

Continued on next page 

                                                 
(1) Future release 
(2) See Appendix B – 802.1Q Ethernet Frame for the description of the Ethernet MAC frame. 
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Setting L2 Ports, Continued 

  
Toolbar of L2 
Port List 
window 

The toolbar of the L2 Port List window includes the following buttons: 

Button Description 

 To retrieve the list entries. 

 To cancel a request. 

 To clear the list. 

 To save the L2 Port list in a text file. 
 

Also, you can press the “+”/ “-”keyboard’s keys to enlarge/ reduce the list’s 
font size. 
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Associating VLANs with L2 Ports 
  

Introduction This paragraph describes how to: 
• View the list providing the current associations of the VLANs with the L2 ports 
• Associate the VLANs you want to an L2 port.  

  
Viewing the 
VLAN Port 
Membership 
List 

To view the list providing the current associations of the VLANs with the L2 
ports, proceed as follows: 
 

Step Action 
1 In the Management Tree, expand the 

OmniBAS node you want and select 
the Control element. 

2 In the Management Control Properties window that appears, click 
the  button (located in the System group box).  

 
3 In the L2 Properties window that appears, click the VLAN Port 

tab.  

 

Continued on next page 
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Associating VLANs with L2 Ports, Continued 

 
Viewing the 
VLAN Port 
Membership 
List (continued) 

 

Step Action 
4 To view the list regarding all associations between VLANs and L2 

ports, click the  button. In the VLAN Port Membership List 
window, click the  button to display the list: 

 
 
NOTE  

In case you want to delete a VLAN port, see par. Removing 
VLAN ports, on page 142. 

 

  
End of procedure. 

Continued on next page 
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Associating VLANs with L2 Ports, Continued 

 
Associating 
VLANs with L2 
ports 

To associate VLANs with an L2 port, proceed as follows: 
 

Step Action 
1 Repeat steps 1 to 3 of the previous par. Viewing the VLAN Port 

Membership List. 
2 First, in the VLAN Port tabbed sheet, select the L2 port you want: 

• Click the   button located next to L2 Port field. 

• In the L2 Port List window that appears, click the  button to 
display the L2 ports of the OmniBAS node. 

• Select the L2 port you want (e.g. Modem 1), click the right mouse 
button and from the drop-down menu select the Select L2 Port 
option. 

The selected L2 port is displayed in the VLAN Port tabbed sheet. 

  

Continued on next page 
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Associating VLANs with L2 Ports, Continued 

 
Associating 
VLANs with 
L2 ports 
(continued) 

 

Step Action 
3 Then, in the VLAN Port tabbed sheet, select the VLAN to be associated 

to the selected L2 port: 
 • Click the   button located next 

to VLAN ID field. 
• In the VLAN List window that 

appears, click the  button 
to display all created VLANs. 

• Select the VLAN you want (e.g. 
VLAN 80), click the right mouse 
button and from the drop-down 
menu select the Select VLAN 
option. 

 The ID of the selected VLAN is displayed in the VLAN Port tabbed 
sheet (1). 

 
4 Click the  button, to create the association(s). 

If you want to verify the creation of the new VLAN port(s), click the 
 button in the VLAN Port tabbed sheet (see par. Viewing the 

VLAN Port Membership List, on page 56). 
 

End of procedure. 

  

                                                 
(1)  If you want to associate more than one VLAN to the selected L2 port, select the Up to check box and 
in the corresponding text box, type the ID of the last VLAN you want to associate. For example, if you 
select the Up to check box and then type VLAN ID = 130, the following six VLANs are requested to be 
associated with the selected L2 port: 100, 110, 112, 114, 120 and 130 (and not the VLAN with ID = 80). 
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Setting Ethernet QoS 
 

Introduction OmniBAS system supports advanced Ethernet QoS functionality at Layer 2/ 3 
of OSI model enabling the traffic prioritization and performing dynamic 
multicast filtering. Ethernet QoS prioritizes network traffic and manages 
available bandwidth so that the most important traffic (packets with higher 
priority) to be forwarded first when network congestion occurs.  
This paragraph describes how to assign: 
• IEEE 802.1 P/Q priority in a VLAN packet (Layer 2).  

Note that, for the priority-to-queue mapping, OmniBAS system supports four 
service classes (queues): 0 (highest queue priority), 1, 2 and 3 (lowest queue 
priority). 

• DSCP (Differentiated Services Code Point) in an IP packet (Layer 3) 
 

NOTE  
In the current OmniBAS release (2.0.0), the IEEE 802.1 P/Q priority 
feature is supported only for the wireless L2 ports. Also, the DSCP 
priority feature is supported only for the GbE ports. 

 
Configuring the 
priority 
mapping of a 
wireless L2 
port 

To configure the priority mapping table of a wireless L2 port, proceed as 
follows: 
 

Step Action 
1 Select the L2 port and retrieve its current attributes, by carrying out 

the procedure described in par. Monitoring/ Modifying L2 ports, on 
page 51 (steps 1 to 7). 

 
When the priority mapping of the L2 port is not enabled (see the 
above screen), the packets are forwarded according their incoming 
VLAN priority(1) (that ranges from 0 for low priority to 7 for high 
priority).   

Continued on next page 

                                                 
(1)  PCP field of the Ethernet MAC frame (see Appendix B – 802.1Q Ethernet Frame). 
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Setting Ethernet QoS, Continued 

 
Configuring the 
priority 
mapping of a 
wireless L2 port 
(continued) 

 

Step Action 
2 To enable the priority mapping of the L2 port, select the VLAN Priority 

check box in the Priority Mapping group box. 

Incoming VLAN Priority 
(7-High to 0-Low)

Priority-to-queue Mapping:
Service Classes (queues) assignment 

(0-High to 3-Low)

When you enable the priority mapping of the L2 port, the VLAN priority 
of the incoming packets can be mapped to one of the four service 
classes (queues) supported by the OmniBAS system. The packets 
with the highest priority queue are always transmitted first and packets 
with lowest priority queue are always transmitted last. 

Continued on next page 
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Setting Ethernet QoS, Continued 

 
Configuring the 
priority 
mapping of a 
wireless L2 
port (continued) 

 

Step Action 
3 Assign a service class (queue) (0 (High), 1, 2 or 3 (Low)) to 

each incoming VLAN priority (0 to 7) by using the corresponding 
drop down-lists. 
In the following example the service class 0 (High) is assigned 
to incoming-VLAN Priority 5: 

 
About Set all bits as drop-down list 
You can use the Set all bits as drop-down list to assign the same 
service class (queue) to all incoming-VLAN priorities. In this way, 
when a service class (queue) is assigned more times than the others, 
you can avoid assigning the service classes (queues) one-by-one (i.e. 
you assign the service class (queue) you want to all incoming-VLAN 
priorities, and then you select the different ones, wherever needed). 

4 When you complete the priority mapping assignments, click the 
 button, to apply the priority mapping settings to the 

selected L2 port. 
 

End of procedure. 

Continued on next page 
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Setting Ethernet QoS, Continued 

 
Configuring the 
DSCP priorities 
of a wireline 
(GbE) L2 port 

To configure the DSCP priority mapping of a wireline (GbE) L2 port, proceed 
as follows: 

Step Action 
1 Configure the priority-to-queue mapping of the GbE port, by 

carrying out a same procedure as this described in the previous 
par. Configuring the priority mapping of a wireless L2 port. 
Then, carry out the following steps to assign DSCP entries(1) and 
associate them with the service classes you have specified. 

2 In the L2 Properties window of the selected Control element, select 
the DSCP Remark tab: 

  

Continued on next page 

                                                 
(1)  The DSCP entry is written to the TOS/DSCP field in the IP header of the incoming packets and takes 
values from 0 for low priority to 63 for high priority. 
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Setting Ethernet QoS, Continued 

 
Configuring the 
DSCP priorities 
of a wireline 
(GbE) L2 port 
(continued) 

 

Step Action 
3 To assign new DSCP entries, select the L2 port you want in the 

DSCP Remarking to P bit group box, as follows: 

• Click the   button located next to L2 Port field. 

• In the L2 Port List window that appears, click the  button to 
display the L2 ports of the OmniBAS node. 

• Select the L2 port you want (e.g. Modem 1), click the right mouse 
button and from the drop-down menu select the Select L2 Port 
option. 

The selected L2 port is displayed in the DSCP Remarking to P bit 
group box. 

  

Continued on next page 



Chapter 3. Configuring OmniBAS System OmniBAS LCT 
User Manual - Edition 1.0

 

  
65

 

Setting Ethernet QoS, Continued 

 
Configuring the 
DSCP priorities 
of a wireline 
(GbE) L2 port 
(continued) 

 

Step Action 
4 Specify a DSCP entry and associate it to a P bit. Actually, the P bit 

corresponds to the service class that is mapped to the VLAN priority 
of the incoming packet. 
To specify a DSCP entry to a P bit, type the DSCP value (from 0 to 
63) to the DSCP text box and the priority P bit value (from 0 to 7) to 
the P bit text box 
To associate more than one DSCP entries to a P bit, type the first 
DSCP value in the DSCP text box, click the Up to check box and 
type the last one in the corresponding text box. 
For instance, the following screen shows that the 16 to 30 DSCP 
values are assigned to P bit = 6. 

 
The following table shows an example of DSCP remarking to P bit: 

DSCP 
values 0 8 16 24 32 40 48 56 

P bit 0 1 2 3 4 5 6 7 
 
 

5 Click the  button, to apply the DSCP remarking to P bit.  
6 If you want to verify the creation of the new DSCP entries, click the 

 button. In the DSCP Entries List window that appears, click 
the  button to display the list of the created DSCP entries. 

 

Continued on next page 



OmniBAS LCT  
User Manual - Edition 1.0 

Chapter 3. Configuring OmniBAS System 

 

66 

 

Setting Ethernet QoS, Continued 

 
Configuring the 
DSCP priorities 
of a wireline 
(GbE) L2 port 
(continued) 

 

Step Action 
7 In case you want to delete DSCP entries, in the DSCP Entries List 

window, click the rows corresponding to the DSCP entries you want 
to remove. Then, click the right mouse button and from the 
drop-down menu: 
• Select the Delete Selected option. The selected DSCP entries 

are removed. 
• Select the Delete All option to remove all DSCP entries. 

 
Alternatively, carry out steps 1 to 5 of the above procedure and in 
the DSCP Remarking to P bit group box, click the  
button. 

 
End of procedure. 

Continued on next page 
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Setting Ethernet QoS, Continued 

 
Enabling/ 
Disabling DSCP 
priorities 

To enable or disable the DSCP priorities of a wireline (GbE) L2 port, proceed 
as follows: 
 

Step Action 
1 

 

In the Management Tree, expand 
the OmniBAS node you want and 
select the Control element. 

2 In the Management Control Properties window that appears, click 
the  button (located in the System group box).  

 
3 In the L2 Properties window that appears, select the DSCP 

Remark tab: 

 

Continued on next page 
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Setting Ethernet QoS, Continued 

 
Enabling/ 
Disabling DSCP 
priorities 
(continued) 

 

Step Action 
4 In the DSCP Remarking State group box, select the L2 port, 

whose DSCP priorities you want to enable or disable: 

• Click the   button located next to L2 Port field. 

• In the L2 Port List window that appears, click the  button 
to display the L2 ports of the OmniBAS node. 

• Select the L2 port you want (e.g. GbE 2), click the right mouse 
button and from the drop-down menu select the Select L2 Port 
option. 

The selected L2 port is displayed in the DSCP Remarking State 
group box. 

 

Continued on next page 
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Setting Ethernet QoS, Continued 

 
Enabling/ 
Disabling DSCP 
priorities 
(continued) 

 

Step Action 
5 Click the  button, to retrieve the current state of the 

selected L2 port. 

 
 

 

In case you want to 
view the DSCP state of 
all L2 ports, click 
the  button and 
in the DSCP Entries 
State List window that 
appears, click the 

 button. 

6 To change the DSCP state of an L2 port, from the State 
drop-down list of the DSCP Remarking State group box, select:  
• Enable, to enable the DSCP properties of the selected L2 port. 
• Disable, to disable the DSCP properties of the selected L2 port. 

Alternatively, you can enable or disable the DSCP state of L2 
ports, as follows: in the DSCP Entries State List window, select 
the L2 ports you want, click the right-mouse button and from the 
drop-down list that appears select to enable/ disable the selected 
ports or all ports of the list. 

 
 

End of procedure.   
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3.3 Configuring PWE3 TDM Connections 
   

 In an OmniBAS node, utilizing PWE3 functionality, TDM traffic is incorporated 
in Ethernet traffic and it is directed through a GbE interface (wireline port) or 
through a modem L2 port (wireless port). Therefore, a PWE3 TDM connection 
is established between an E1 line (provided by the Interface 16E1 module) and 
the one of the two GbE ports or one of the four wireless ports. 
The following step-by-step procedures must be carried out for creating PWE3 
TDM connections in an OmniBAS node: 

 
 # Procedure Page
1 Configuring an E1 Line  71 
2 Creating VLANs 49 
3 • Creating PWE3 TDM Connections (through GbE Ports)  74 
 • Creating PWE3 TDM Connections (through Modem L2 Ports)  81 
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Configuring an E1 Line 
  

Introduction This paragraph describes how to: 
• Set the frame type of an E1 line 
• Enable/ Disable an E1 line 
The configuration of an E1 line is performed through the corresponding 
Management E1 Properties window. 

 
Setting the E1 
frame type 

To set the frame type of an E1 line, proceed as follows: 

 
Step Action 

1 In the Management Tree, expand the 
Interface 16E1 element and click the 
E1 line you want (e.g. E1 Line 1). 

2 In the Management E1 Properties window, click the  button 
to view the current properties of the selected line. 

 

Continued on next page 
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Configuring an E1 Line, Continued 

  
Setting the E1 frame type (continued) 
 

Step Action 
3 In the E1 Line Properties group box, click the Frame Type 

drop-down list and select the E1 frame format you want. 
• Doubleframe (no signaling): G.704 structured. Timeslots TS1 to 

TS31 transfer payload. Frame synchronization is carried over 
timeslot TS0. No payload signaling is used. 

• Multiframe-CRC (no signaling): G.704 structured. Timeslots TS1 
to TS31 transfer payload. Frame synchronization is carried over 
timeslot TS0. The Si bits of each Frame Alignment Signal (FAS) 
are used to implement CRC-4 control. No payload signaling is 
used. 

• Unframed (unstructured): stream of bits at 2048 kbit/s; 
no channels are associated with any specific group of bits. 

 
4 In the Management E1 Properties window, click the  button 

to apply the new setting to the selected E1 Line. 
 NOTE  

If you want to apply the new setting to all E1 Lines that are 
not associated with a connection, click the  

button (instead of the  button). 
 

End of procedure. 

Continued on next page 
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Configuring an E1 Line, Continued 

  
Enabling/ dis-
abling an E1 line 

To enable/ disable an E1 line, proceed as follows: 

 
Step Action 

1 In the Management Tree, expand the 
Interface 16E1 element and click the E1 
line you want (e.g. E1 Line 1). 

2 In the Management E1 Properties window, click the  
button to view the current properties of the selected line. 

 
3 From the Administrative Status drop-down list of the E1 Admin 

State group box, select: 
• Enable, to enable the selected E1 line 
• Disable, to disable the selected E1 line 

 
4 Click the  button to apply the new setting to the selected E1 

line. 
 

End of procedure.  
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Creating PWE3 TDM Connections (through GbE Ports) 
  

Introduction This paragraph describes how to create PWE3 TDM connections through the 
GbE ports in an OmniBAS node.  
OmniLCT application provides a Connection Setup Wizard for the quick and 
easy creation of the OmniBAS connections. 
Note that in a PWE3 TDM connection, all 32 timeslots of the selected E1 line 
are used. 

  
Procedure To create PWE3 TDM connections through the GbE ports, proceed as 

follows: 
 

Step Action 
1 On the Main Menu, select Tools > Connection Wizard (or click 
 , on the Toolbar). 

2 In the first Wizard screen that appears, click the Next button. The 
Select Source screen appears: 

 

Continued on next page 
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Creating PWE3 TDM Connections (through GbE Ports), Continued 

  
Procedure (continued) 
 

Step Action 
3 Click the  button. The mouse pointer will change to a hand ( ). 

Use this hand ( ) and select the source point of the connection to be 
created in the Management Tree.  

 This point is one of the available E1 
lines (e.g. E1 Line 2) of the selected 
Interface 16E1 element. 

4 When you select the source point in the Management Tree (e.g. E1 
Line 2), the source data are automatically entered in the 
corresponding fields (Card, Interface, Line and TS) of the wizard 
and the Time Slot Selection window appears. 

 
 NOTE  

All 32 timeslots of the selected E1 line must be selected in a 
PWE3 TDM connection. 
As a result, when you select the source point in the 
Management Tree (e.g. E1 Line 2), the TS (timeslots) field 
automatically takes the value 0-31 and also the Time Slot 
Selection window appears with all timeslots selected. 

Continued on next page 
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Creating PWE3 TDM Connections (through GbE Ports), Continued 

  
Procedure (continued) 
 

Step Action 
5 If you want to connect more that one contiguous E1 Lines with a 

specific GbE port, click the  button located next to Up to Line 
field.  The mouse pointer will change to a hand ( ).  
In the Management Tree, use this hand ( ) to select the last E1 Line. 
For instance, by selecting the E1 Line 2 as the first source point and 
the E1 Line 4 as the last, the E1 Line 2, E1 Line 3 and E1 Line 4 are 
selected as source points.  

6 After completing the source data selection, click the Next button. The 
Select Target screen appears: 

 

Continued on next page 
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Creating PWE3 TDM Connections (through GbE Ports), Continued 

  
Procedure (continued) 
 

Step Action 
7 Click the  button. The mouse pointer will change to a hand ( ). 

Use this hand ( ) and select the target point of the connection(s) to 
be created in the Management Tree. 

 

 

This point is one of the two GbE ports (e.g. 
GbE Port 1). 

8 When you select the target point in the Management Tree (e.g. GbE 
Port 1), the target data are automatically entered in the 
corresponding fields (Card and GbE) of the wizard. 

 
9 After completing the target data selection, click the Next button. The 

TDM PWE3 Connection screen appears to define the attributes of 
the TDM PWE3 connection(s) to be created. 

 

Continued on next page 
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Creating PWE3 TDM Connections (through GbE Ports), Continued 

  
Procedure (continued) 
 

Step Action 
10 Consult the following table to define the parameters of the 

connection(s): 

Parameter Description 
ECID 
Ingress 

Ingress Emulated Circuit Identifier for the GbE side of 
the PWE3 TDM connection. (Value range: 1 to 65535)(1)

ECID 
Egress 

Egress Emulated Circuit Identifier for the GbE side of 
the PWE3 TDM connection. (Value range: 1 to 65535)(1)

Destination 
MAC 
Address 

In the Destination MAC Address text box, enter the 
MAC address of the tributary module on which the 
created PWE3 TDM connection terminates. 

Buffered E1 
Frames 

This parameter is used to calculate the PSN packet 
size(2). By default, the value is 8.  
(Value Range: 1 to 255). 

Packet 
Jitter 

Refers to the latency of the packets. By default, the 
value is 10000. (Value range: 250 μsec to 30000 μsec). 

Payload 
Suppress 

Select the Payload Suppress check box to stop 
transmitting packets when E1 has nothing to send (all 
zeros). 

VLAN Exist Select the VLAN Exist check box in case you want to 
associate a VLAN to the GbE port. 

VLAN ID Enter the VLAN ID. (To view the VLANs list, see par. 
VLAN List, on page 138). 

VLAN 
Priority Bits 

From the VLAN Priority Bits drop down list, select the 
802.1p priority bit. It takes values from 0 to 7  
(7 is the highest priority, 0 is the lowest priority). 

 
 

Continued on next page 

                                                 
(1)  When you create more than one connection, select also the Auto Advance check box. When this 

check box is selected the value entered in the ECID Ingress/ Egress field is increased in steps of 1 for 
generating ECID Ingress/ Egress values for all connections that are going to be created. 

(2)  PSN: Packet Switched Network,  
     PSN packet size = (Buffered E1 frames) x (nSlots), where nSlots = 32 in unstructured mode. 
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Creating PWE3 TDM Connections (through GbE Ports), Continued 

  
Procedure (continued) 
 

Step Action 
11 When you complete, click the Next button. The Connect Source and 

Target screen appears: 

 
Click the Finish button to establish the new TDM PWE3 connection(s). 

Continued on next page 
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Creating PWE3 TDM Connections (through GbE Ports), Continued 

  
Procedure (continued) 

 
Step Action 
12 When the connections are established successfully, the “TDM PWE3 

CONNECTION RESPONSE OK” messages appear (a message for 
each connection request). Click the Close button to close the wizard. 

 
In case of failure, the “TDM PWE3 CONNECTION RESPONSE WITH 
ERROR!” message appears. Use the Back button to check again the 
connection settings and try again. 

 NOTE  
To view the Connections List window that display all created 
connections of the OmniBAS node, see par. Connections 
List, on page 134. 

 
End of procedure. 
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Creating PWE3 TDM Connections (through Modem L2 Ports) 
  

Introduction This paragraph describes how to create PWE3 TDM connections through the 
modem L2 (wireless) ports in an OmniBAS node.  
OmniLCT application provides a Connection Setup Wizard for the quick and 
easy creation of the OmniBAS connections. 
Note that in a PWE3 TDM connection, all 32 timeslots of the selected E1 line 
are used. 

  
Procedure To create PWE3 TDM connections through the wireless ports, proceed as 

follows: 
 

Step Action 
1 On the Main Menu, select Tools > Connection Wizard (or click 
 , on the Toolbar). 

2 In the first Wizard screen that appears, click the Next button. The 
Select Source screen appears: 

 

Continued on next page 



OmniBAS LCT  
User Manual - Edition 1.0 

Chapter 3. Configuring OmniBAS System 

 

82 

 

Creating PWE3 TDM Connections (through Modem L2 Ports), 
Continued 

  
Procedure (continued) 
 

Step Action 
3 Click the  button. The mouse pointer will change to a hand ( ). 

Use this hand ( ) and select the source point of the connection to be 
created in the Management Tree.  

 This point is one of the available E1 
lines (e.g. E1 Line 2) of the selected 
Interface 16E1 element. 

4 When you select the source point in the Management Tree (e.g. E1 
Line 2), the source data are automatically entered in the 
corresponding fields (Card, Interface, Line and TS) of the wizard 
and the Time Slot Selection window appears. 

 
 NOTE  

All 32 timeslots of the selected E1 line must be selected in 
a PWE3 TDM connection. 
As a result, when you select the source point in the 
Management Tree (e.g. E1 Line 2), the TS (timeslots) field 
automatically takes the value 0-31 and also the Time Slot 
Selection window appears with all timeslots selected. 

Continued on next page 
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Creating PWE3 TDM Connections (through Modem L2 Ports), 
Continued 

  
Procedure (continued) 
 

Step Action 
5 If you want to connect more that one contiguous E1 Lines with a 

specific GbE port, click the  button located next to Up to Line 
field.  The mouse pointer will change to a hand ( ).  
In the Management Tree, use this hand ( ) to select the last E1 Line. 
For instance, by selecting the E1 Line 2 as the first source point and 
the E1 Line 4 as the last, the E1 Line 2, E1 Line 3 and E1 Line 4 are 
selected as source points.  

6 After completing the source data selection, click the Next button. The 
Select Target screen appears: 

 

Continued on next page 
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Creating PWE3 TDM Connections (through Modem L2 Ports), 
Continued 

  
Procedure (continued) 
 

Step Action 
7 Click the  button. The mouse pointer will change to a hand ( ). 

Use this hand ( ) and select the target point of the connection(s) to 
be created in the Management Tree. 

 This point is one of the four wireless 
ports (e.g. PtP slot 1 corresponding to 
modem located in slot 1). 

8 When you select the target point in the Management Tree (e.g. PtP 
slot 1), the target data are automatically entered in the corresponding 
fields (Card and Port) of the wizard. 

 

Continued on next page 
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Creating PWE3 TDM Connections (through Modem L2 Ports), 
Continued 

  
Procedure (continued) 
 

Step Action 
9 After completing the target data selection, click the Next button. The 

TDM PWE3 Connection screen appears to define the attributes of 
the TDM PWE3 connection(s) to be created. 

 

Continued on next page 
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Creating PWE3 TDM Connections (through Modem L2 Ports), 
Continued 

  
Procedure (continued) 
 

Step Action 
10 Consult the following table to define the parameters of the 

connection(s): 

Parameter Description 
ECID 
Ingress 

Ingress Emulated Circuit Identifier for the wireless ports 
side of the PWE3 TDM connection. (Value range: 1 to 
65535)(1) 

ECID 
Egress 

Egress Emulated Circuit Identifier for the wireless ports of 
the PWE3 TDM connection. (Value range: 1 to 65535)(1) 

Destination 
MAC 
Address 

In the Destination MAC Address text box, enter the 
MAC address of the tributary module on which the 
created PWE3 TDM connection terminates. 

Buffered E1 
Frames 

This parameter is used to calculate the PSN packet 
size(2). By default, the value is 8. (Value Range: 1 to 
255). 

Packet 
Jitter 

Refers to the latency of the packets. By default, the value 
is 10000. (Value range: 250 μsec to 30000 μsec).  

Payload 
Suppress 

Select the Payload Suppress check box to stop 
transmitting packets when E1 has nothing to send (all 
zeros). 

VLAN Exist Select the VLAN Exist check box in case you want to 
associate a VLAN to the GbE port. 

VLAN ID Enter the VLAN ID. (To view the VLANs list, see par. 
VLAN List, on page 138). 

VLAN 
Priority Bits 

From the VLAN Priority Bits drop down list, select the 
802.1p priority bit. It takes values from 0 to 7  
(7 is the highest priority, 0 is the lowest priority). 

 
 

Continued on next page 

                                                 
(1)  When you create more than one connection, select also the Auto Advance check box. When this 

check box is selected the value entered in the ECID Ingress/ Egress field is increased in steps of 1 for 
generating ECID Ingress/ Egress values for all connections that are going to be created. 

(2)  PSN packet size = (Buffered E1 frames) x (nSlots), where nSlots = 32 in unstructured mode. 
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Creating PWE3 TDM Connections (through Modem L2 Ports), 
Continued 

  
Procedure (continued) 
 

Step Action 
11 When you complete, click the Next button. The Connect Source and 

Target screen appears: 

Click the Finish button to establish the new TDM PWE3 connection(s). 

Continued on next page 
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Creating PWE3 TDM Connections (through Modem L2 Ports), 
Continued 

  
Procedure (continued) 

 
Step Action 
12 When the connections are established successfully, the “TDM PWE3 

CONNECTION RESPONSE OK” messages appear (a message for 
each connection request). Click the Close button to close the wizard. 

In case of failure, the “TDM PWE3 CONNECTION RESPONSE WITH 
ERROR!” message appears. Use the Back button to check again the 
connection settings and try again 

 NOTE  
To view the Connections List window that display all created 
connections of the OmniBAS node, see par. Connections 
List, on page 134. 

 
End of procedure. 
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3.4 Setting Static MAC Addresses 
 

Introduction This paragraph describes how to: 
• View the static MAC addresses of an OmniBAS node 
• Create static MAC addresses in an OmniBAS node 
• Delete static MAC addresses of an OmniBAS node 
Forwarding process feature ensures that only specific MAC addresses can 
access an L2 port (and traffic from any other MAC addresses will be discarded). 

 
Viewing static 
MAC addresses 
list 

To view the static MAC address list of an OmniBAS node, proceed as follows: 
 

Step Action 
1 In the Management Tree, expand the 

OmniBAS node you want and select 
the Control element. 

2 In the Management Control Properties window that appears, click 
the  button (located in the System group box).  

 
3 In the L2 Properties window, click the MAC Address tab to display 

the Forwarding Table Entries tabbed sheet. 

Continued on next page 
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Setting Static MAC Addresses, Continued 

 
Viewing static 
MAC addresses 
list (continued) 

 

Step Action 
4 In the Forwarding Table Entries tabbed sheet, click the  

button to display the MAC Address List window. 

5 Click the  button to display the list of all static MAC 
addresses of the OmniBAS node. 
Each row of the list indicates the L2 port to which a received 
frame with specific VLAN ID and destination MAC address is 
forwarded. When no entries are found for a received frame, the 
frame is sent to all L2 ports. 

  
End of procedure. 

Continued on next page 
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Setting Static MAC Addresses, Continued 

 
Creating a 
static MAC 
address 

To create a static MAC address, proceed as follows: 
 

Step Action 
1 In the Management Tree, expand the 

OmniBAS node you want and select the 
Control element. 

2 In the Management Control Properties window that appears, click 
the  button (located in the System group box).  

 
3 In the L2 Properties window, click the MAC Address tab to 

display the Forwarding Table Entries tabbed sheet. 

 

Continued on next page 
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Setting Static MAC Addresses, Continued 

 
Creating a 
static MAC 
address 
(continued) 

 

Step Action 
4 In the MAC address text box, enter the destination MAC address. 

 
5 Carry out the following instructions to select the VLAN you want to 

associate with this MAC address: 

• Click the   button located next to VLAN field. 

• In the VLAN List window that appears, click the  button to 
display all created VLANs. 

• Select the VLAN you want (e.g. VLAN 10), click the right mouse 
button and from the drop-down menu select the Select VLAN 
option. 

 
The ID of the selected VLAN is displayed in the Forwarding Table 
Entries tabbed sheet. 

Continued on next page 
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Setting Static MAC Addresses, Continued 

 
Creating a 
static MAC 
address 
(continued) 

 

Step Action 
6 Select the outgoing L2 port, as follows: 

• Click the   button located next to Outgoing L2 Port field. 

• In the L2 Port List window that appears, click the  button 
to display the L2 ports of the OmniBAS node. 

• Select the L2 port you want (e.g. Modem 1), click the right 
mouse button and from the drop-down menu select the Select 
L2 Port option. 

 
The selected L2 port is displayed in the Forwarding Table Entries 
tabbed sheet. 

7 Click the  button, to create the static MAC address.  
  
End of procedure. 

Continued on next page 
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Setting Static MAC Addresses, Continued 

 
Removing a 
static MAC 
address 

To remove static MAC addresses from an OmniBAS node, proceed as 
follows: 
 

Step Action 
1 Activate the MAC Address List window of the OmniBAS node, as 

described in the previous par. Viewing static MAC addresses list, 
on page 89. 

2 In the MAC Address List window, select the static MAC address 
you want, click the right mouse button and from the drop-down 
menu that appears, select: 
• Delete Selected, to delete the selected MAC address 
• Delete All, to delete all existing MAC addresses 

 
The selected MAC addresses are removed from the OmniBAS 
node. 

  
End of procedure. 
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3.5 Setting/ Monitoring System Synchronization 
  

Introduction This chapter describes how to set the OmniBAS nodes synchronization 
providing the following procedures: 
• Setting the operation mode of the synchronization (Normal or FreeRun). 

The synchronization of the OmniBAS system can be derived through either 
the local oscillator (FreeRun operation mode) or one of the eight available 
clocks (Normal operation mode). 

• Defining the clock source (in case of Normal operation mode). 
• Monitoring the current state of the system synchronization. 

  
Setting the 
synchronization 
operation mode  

To set the OmniBAS node synchronization, first select the synchronization 
operation mode (Normal or FreeRun): 
To set the operation mode of an OmniBAS node, proceed as follows: 

 

Step Action 
1 

 

In the Management Tree, expand 
the OmniBAS node you want and 
select the Control element. 

2 In the Management Control Properties window that appears, click 
the  button to update the displayed data.  

 

Continued on next page 
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Setting/ Monitoring System Synchronization, Continued 

  
Setting the synchronization operation mode (continued) 
 

Step Action 
3 From the Operation Mode drop-down list of the Synchronization 

group box, select: 
• FreeRun, the system gets synchronization from the internal oscillator 

of the processor module. 
• Normal, the system gets clock synchronization from one of the eight 

available clock sources. 
 

NOTE

 

If you select Normal operation mode, you must also select 
the clock source to be used for the synchronization of the 
system, as described in the following par. Defining the clock 
source, on page 97 

 

 
4 Click the corresponding  button to apply the setting. 
 

NOTE  
To verify that the setting is applied, click the  button, 
to refresh the displayed data in the Synchronization group 
box. 

 
End of procedure. 

Continued on next page 
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Setting/ Monitoring System Synchronization, Continued 

  
Defining the 
clock source 

To select the clock source needed for the system synchronization (in case of 
Normal operation mode) , proceed as follows: 

 
Step Action 

1 From the Clock Source drop-down list of the Synchronization 
group box, select the clock source to be used for the system 
synchronization (e.g. Modem BL).  

 
OmniBAS system provides the following eight clock sources: 

Clock Source(1) Timing signal retrieved from: 
Sync In Sync IN port of the processor module 

Modem BL Modem located in slot 1 
Modem TL Modem located in slot 2 
Modem BR Modem located in slot 3 
Modem TR Modem located in slot 4 

GE 1 GbE port 1 of the processor module 
GE 2 GbE port 2 of the processor module 

Interface Card An E1 port of the Interface E1 tributary module 
 
 

2 If you select the Interface Card as clock source proceed to step 3. 
Otherwise, proceed to step 4. 

Continued on next page 

                                                 
(1)  To identify the slots position, see par. Modems slot numbering, on page 17. 
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Setting/ Monitoring System Synchronization, Continued 

  
Defining the clock source (continued) 
 

Step Action 
3 When you select the Interface Card as clock source, an E1 line must 

be selected too. To select the E1 line: 
 

 

• In the Management Tree, 
click the Interface 16E1 
element. 

 • In the Management 
Interface Properties 
window that appears, 
click the  button 

 • From the E1 Line Clock Selection drop-down list, select the E1 
Line (e.g. E1 Line 1) to be associated with the clock source. 

• Click the  button, to apply the E1 line’s selection. 
• In the Management Tree, select again the Control element. The 

Management Control Properties window appears. 

Continued on next page 
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Setting/ Monitoring System Synchronization, Continued 

  
Defining the clock source (continued) 

 
Step Action 

4 In the Synchronization group box, click the corresponding  
button to apply the clock source setting. 

 
The system succeeds to lock in the selected clock source, when  
Is Locked = True (i.e. the system has succeeded in finding an 
acceptable clock source and has locked to it)(1). 

 
NOTE  

To verify that the clock source setting is applied, click the 
 button, to refresh the displayed data in the 

Synchronization group box. 
 

End of procedure. 

 Continued on next page 

                                                 
(1)  Holdover State: The system loses the clock to which it is locked and fails to find any other available clock. 

Out of Range: When clock is out of its nominal frequency by more than ±12 ppm.  
Note also that Priority is not supported in the current OmniLCT release (1.1.3).  
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Setting/ Monitoring System Synchronization, Continued 

  
Monitoring the 
state of system 
synchronization 

Through the State box, you can monitor the current status of the system 
synchronization. 

State box

 
The possible values of the synchronization state are shown in the following 
table: 

State value Description 
Locked Indicates that the system has succeeded in finding an 

acceptable clock source and has locked to it. 
HoldOver The system enters HoldOver mode as soon as it loses the 

clock to which it is locked and fails to find any other available 
clock. Being in HoldOver mode, the system tries to simulate 
the previous clock by making use of an internal memory. 

FreeRun The system enters FreeRun mode when there is no available 
clock source and the internal simulation memory of the 
system has not been filled up to allow the system work in 
HoldOver mode. 

 
 

 

 NOTE  
Do not confuse the “state” of the synchronization with the “operation 
mode”. For example, even though the Normal operation mode is 
selected, it is possible the FreeRun or HoldOver (instead of Locked) 
synchronization status to be displayed in the State box, due to 
unavailability of adequate clock sources.  
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4 Monitoring an OmniBAS Node 
  

 This chapter describes how to monitor an entire OmniBAS node on-line, and 
also how to define basic operational parameters. The monitoring of the 
OmniBAS node regards: 
• Monitoring Fan Trays/ Power Supplies/ External Alarms 
• Monitoring the Control 
• Monitoring the GbE Ports 
• Monitoring the Interface 16E1 Element 
• Monitoring the E1 Line 
• Monitoring the Modem 
• Monitoring the ODU 
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 Monitoring Fan Trays/ Power Supplies/ External Alarms 
  

Introduction This paragraph describes how to monitor: 
• The status of the power and fan modules of the OmniBAS-4W subrack 
• The status of the external alarms  
The monitoring of the above items is performed through the Management Fan 
Tray – PSU Properties window. 

  
Monitoring 
procedure 

To monitor the power and fan modules and the external alarms of the 
OmniBAS-4W, proceed as follows: 

 
Step Action 

1 In the Management Tree, click the 
top element (e.g. 192.168.57.9); this 
element corresponds to the 
OmniBAS-4W subrack. 

2 In the OmniBAS System properties window, click the  
button. 

 

Continued on next page 
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Monitoring Fan Trays/ Power Supplies/ External Alarms, 
Continued 

  
Monitoring procedure (continued) 

 
Step Action 

3 In the Management Fan Tray – PSU Properties window that 
appears, click the  button to update all displayed fields. 

 
4 The Power Supply group box refers to the power modules of the 

OmiBAS-4W subrack. The PSU 1 corresponds to the main power 
module, while the PSU 2 to the redundant one. If a power supply 
module fails, the other takes over all load; if both are OK, the load is 
shared. 
For each power module (Main - PSU 1 or Redundant - PSU2), you 
can check: 
• Its physical state. When the power module is in place, the 

corresponding Existence “virtual” led is green. Otherwise, it is red. 
• Its operational status. When the power module operates normally, 

the corresponding Working “virtual” led is green. Otherwise, it is 
red. 

5 In the Temperature group box, you can view the upper and lower 
threshold values that factory predefined for the temperature 
associated with the fans speed (Low, Medium or High). 

Continued on next page 
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Monitoring Fan Trays/ Power Supplies/ External Alarms, 
Continued 

  
Monitoring procedure (continued) 

 
Step Action 

6 The Fan Tray group box refers to the fan module of the OmiBAS-4W 
subrack.  

 
Through this group box, you can check: 
• The physical state of the fan module. When it is in place, the 

Existence “virtual” led is green. Otherwise, it is red. 
• The operational status of the fan module. When a problem occurs, 

the corresponding Alarm “virtual” led is red. Normally, the Alarm 
“virtual” led must be grey. 

• The Speed of the fans. The fans operate at: 
− Low speed, when the OmiBAS-4W current temperature (1) is 

lower than the Temperature Lower Threshold. 
− Medium speed, when the OmiBAS-4W current temperature (1) is 

between the Lower and Upper Thresholds. 
− High speed, when the OmiBAS-4W current temperature (1) 

exceeds the Temperature Upper Threshold. 

Continued on next page 

                                                 
(1)  OmiBAS-4W current temperature is displayed in the Management Control Properties window (see 
par.Monitoring the Control Element, on page 106). 
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Monitoring Fan Trays/ Power Supplies/ External Alarms, 
Continued 

  
Monitoring procedure (continued) 

 
Step Action 

7 

 

The External Alarms group box refers to 
external devices (e.g. fan trays located in the 
doors of an outdoor cabinet in which the 
OmniBAS-4W subrack is placed). 

 • You can check the current operating status of the external devices 
by checking the status of the Input 1 and Input 2 “virtual” leds. 
Normally, the leds must be grey. A red coloured (ON) led indicates 
an alarm condition. 

• You can activate/ deactivate an external device by selecting/ 
unselecting the corresponding Output check box (Output 1, 
Output 2). 

  
End of procedure. 

  



OmniBAS LCT  
User Manual - Edition 1.0 

Chapter 4. Monitoring an OmniBAS Node 

 

106 

 

Monitoring the Control Element 
  

Introduction This paragraph describes: 
• How to set the upper temperature threshold of the OmniBAS-4W subrack’s 

processor module and also how to monitor the temperature inside the 
module. 

• How to check the release of the OmniBAS system 
• How to restore the default settings of the OmniBAS system 
The monitoring of the Control element of an OmniBAS node is performed 
through the Management Control Properties window (that appears when you 
select the Control element in the Management Tree). 

Regarding the Control element, you can also perform the actions listed in the 
following table. For these actions, refer to the corresponding paragraphs 
(shown in the Reference column).  
 

Action Reference 
Monitoring the protection status of 
the OmniBAS node 

Par. Configuring the Protection of an 
OmniBAS Node (page 26) 

Using L2 Properties button. Par. 3.2 Configuring Ethernet Traffic (page 
46) 

Configuring system 
synchronization 

Par. 3.5 Setting/ Monitoring System 
Synchronization (page 95) 

Resetting the processor module Par. Resetting Processor Module (page 174) 
Performing a Store, Backup or 
Restore action. 

Par. 7.1 Performing Store, Backup or Restore 
Action (page 164) 

Performing a Clear CFG action. Par. 7.3 Clearing OmniBAS Node 
Configuration (page 180)  

Continued on next page 
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Monitoring the Control Element, Continued 

 
Monitoring 
Control element 

To monitor the current status of the Control element of an OmniBAS node, 
proceed a follows: 

 
Step Action 

1 

 

In the Management Tree, expand the 
OmniBAS node you want and select 
the Control element. 

2 In the Management Control Properties window that appears, click 
the  button to update the displayed data. 

 

Continued on next page 
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Monitoring the Control Element, Continued 

  
Monitoring Control element (continued) 
 

Step Action 
3 In the Temperature group box, you can view the current temperature 

inside the processor module of the OmniBAS-4W subrack (e.g. 38 ºC). 
 Through the Temperature group box of the 

Management Control Properties window, you 
can also set the upper temperature threshold 
for the processor module of the OmniBAS-4W 
subrack.  
To do this, use the up/ down arrows ( ) of the 
Upper Threshold field to select the upper 
temperature threshold you want (it does not 

exceed 60 ºC). Then click the  button to 
apply the new setting. 

4 In the System Version field of the System group box, you can view 
the current release of the OmniBAS system (1). 

 
Besides, in the Actual Rack Sys Type field, the PtP (Point-to-Point) 
value is displayed. 

 
End of procedure. 

 

                                                 
(1)  In case you need to upgrade the firmware of the OmniBAS system, refer to the Start Up & Commissioning 
Manual of the OmniBAS system.   
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Monitoring the GbE Ports 
  

Introduction This paragraph describes how to monitor the status of the electrical and 
optical GbE ports.  
OmniLCT application detects the physical type of the selected GbE port 
(electrical or optical), displaying the corresponding Management GbE 
Properties window. 

  
Monitoring 
electrical GbE 
port 

To monitor the current status of an electrical GbE Port, proceed a follows: 
 

Step Action 
1 In the Management Tree, click the 

GbE Port you want to monitor its 
status. 

2 In the Management GbE Properties window, click the  
button to retrieve information regarding the selected GbE port. 

3 Through the GbE Properties group box, you can check the current 
status of the selected GbE port: 
• Type – Indicates the type of the port (Electrical) 
• Link Status – Indicates if the link associated with this port is 

operating normally (Up) or not (Down). 
  
End of procedure. 

 Continued on next page 
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Monitoring the GbE Ports, Continued 

  
Monitoring an 
optical GbE port 

To monitor the current status of an optical GbE Port, proceed a follows: 

 

Step Action 
1 

 

In the Management Tree, click the 
GbE Port you want to monitor its 
status. 

2 In the Management GbE Properties window, click the  button 
to retrieve information regarding the selected GbE port. 

3 Through the GbE Properties group box, you can check the current 
status of the selected GbE port: 
• Type – Indicates the type of the port (Optical) 
• Existence Status – Indicates the physical state of the selected 

GbE port. When the optical GbE port is in place, the Exist value 
appears. Otherwise, the Not Exist value appears. 

• Tx Status – Indicates if the link associated with this port is 
Enabled or Disabled. 

4 Through the Laser Status group box, you can monitor the laser 
status of this optical GbE port (Laser On or Laser Off). 
• If you want to deactivate the GbE port, click the  button. 
• To activate again the GbE port, click the  button. 

5 Through the GbE Alarms group box, you can monitor the GbE 
alarms. Normally, the “virtual” leds of the alarms must be grey. 
The “virtual” led of the following alarms turns on (red) when: 
• LOS –  There is no signal at the specific GbE port input 
• FIS –  There is fault in the output signal of the specific GbE port 

 
End of procedure. 
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Monitoring the Interface 16E1 Element 
   

Introduction This paragraph describes how to monitor the status of the Interface 16E1 
element. The Interface 16E1 element corresponds to E1 Tributary Module of 
the OmniBAS-4W subrack. 

  
Monitoring 
Interface 16E1 

To monitor the current status of the Interface 16E1 element, proceed as 
follows: 

 
Step Action 

1 

 

In the Management Tree, click the 
Interface 16E1 element. 

2 In the Management Interface Properties window, click the  
button to retrieve information regarding the selected element. 

 
3 In the PWE Src MAC Address field, you can view the MAC address 

of the Tributary module of the selected OmniBAS node. 
4 In the E1 Line Clock Selection field, you can see the E1 line used 

as clock source for the system synchronization (when the Interface 
Card is selected as clock source). For more information, see par. 
Setting/ Monitoring System Synchronization, on page 95. 

 
NOTE

 

For the selected Interface 16E1 element, you can also monitor the 
status of the associated E1 Lines, by clicking the  button. 
For more information about this feature, see par. Monitoring the E1 
Lines, on page 112. 

 
End of procedure. 
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Monitoring the E1 Lines 
  

Introduction This paragraph describes how to: 
• View the attributes of an E1 line (frame type, administrative state, alarms 

status, TS usage) 
• View a list of all E1 lines together with their attributes 
• Perform loopback tests in an E1 line 

 
Monitoring the 
properties of an 
E1 Line 

To monitor the current status of an E1 line, proceed as follows: 

 
Step Action 

1 

 

In the Management Tree, expand the 
Interface 16E1 element and click the E1 
line you want (e.g. E1 Line 1). 

2 In the Management E1 Properties window, click the  button 
to view the current properties of the selected line. 

 

Continued on next page 
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Monitoring the E1 Lines, Continued 

  
Monitoring the properties of an E1 Line (continued) 
 

Step Action 
3 In the Frame Type drop-down list of the E1 Line Properties group 

box, you can see the current E1 frame format: 
• Doubleframe (no signaling): G.704 structured. Timeslots TS1 to 

TS31 transfer payload. Frame synchronization is carried over 
timeslot TS0. No payload signaling is used. 

• Multiframe-CRC (no signaling): G.704 structured. Timeslots TS1 
to TS31 transfer payload. Frame synchronization is carried over 
timeslot TS0. The Si bits of each Frame Alignment Signal (FAS) 
are used to implement CRC-4 control. No payload signaling is 
used. 

• Unframed (unstructured): stream of bits at 2048 kbit/s; 
no channels are associated with any specific group of bits. 

 
4 In the Clock Mode field the None value is displayed (i.e. the timing 

of the E1 frame is retrieved from the synchronization network). 
5 In the E1 Line Status group box, you can check if active alarms 

(LOS, OOF, AIS, RAI and Power Down) currently exist for the 
selected E1 Line. 

 
A red icon, next to an alarm, denotes an active alarm of this type. 
Normally, all five alarm icons must be grey (denoting no alarms).  

6 In the Time Slot Usage field, you can view the timeslots status of 
the selected E1 line: When all timeslots are selected (√), they are 
associated with a PWE3 TDM connection. Otherwise, the timeslots 
are displayed unselected. 

 
 

End of procedure. 

Continued on next page 
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Monitoring the E1 Lines, Continued 

  
Massive 
monitoring of 
E1 Lines 

To monitor the E1 lines status of an OmniBAS node, proceed as follows: 

 
Step Action 

1 

 

In the Management Tree, click the 
Interface 16E1 element of the 
OmniBAS node. 
 

2 In the Management Interface Properties window that appears, click 
the  button. 

 
3 In the E1 Line State window that appears, click the  button to 

display the current information regarding the E1 lines. 

 
The 16 E1 lines of the selected Interface 16E1 element are 
displayed together with their attributes (frame type, TS usage, 
alarms status, administrative state, loopback status, etc.). 

 
End of procedure. 

Continued on next page 
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Monitoring the E1 Lines, Continued 

  
Performing 
loopbacks in an 
E1 Line 

To perform loopback test in case of E1 (PWE3 TDM) line fault, proceed as 
follows: 

 

Step Action 
1 

 

In the Management Tree, expand the 
Interface 16E1 element and click the E1 
line you want (e.g. E1 Line 1). 

2 In the Management E1 Properties window, click the  button 
to view the current properties of the selected line. 

3 

 

In the Loopback Test 
group box, expand E1 
Line. 

Continued on next page 
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Monitoring the E1 Lines, Continued 

  
Performing loopbacks in an E1 Line (continued) 
 

Step Action 
4 Expand either LOCAL or REMOTE and then click the loopback you 

want to perform, LIU or Framer.  
See schematic below showing the different loopback tests that can 
be set in case of E1 (PWE3 TDM) line fault. 

 
NOTE  

Framer loopback cannot be set for unframed (unstructured) 
PWE3 TDM services. 

5 Click the  button to set the loopback.  
6 To see the current status of the loopback (Running, Idle), click the 

 button. The current status of the loopback is displayed in 
the Current status field. 

7 When you want to terminate the loopback, click the  button. 
 
 

E1 Line Module

1
16

E1 Tributary Module

LIU FramerE1 Line

Processor Module

To Remote 
OmniBAS Node

Rx

Tx

Rx

Tx

E1 Line Module
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Troubleshooting

Troubleshooting

 
End of procedure. 

 



Chapter 4. Monitoring an OmniBAS Node OmniBAS LCT 
User Manual - Edition 1.0

 

  
117

 

Monitoring the Modems 
  

Introduction This paragraph describes how to: 
• Monitor whether a modem is in standalone or protection mode 
• Monitor the current temperature inside a modem 
• Monitor the current status of a modem (modulation, lock indicators,  

alarms, etc.) 
• Identify the corresponding remote modem and also monitor the link status  
The monitoring of the above items is performed through the Management PtP 
Modem Properties window. 

  
Monitoring 
modem status 

To monitor the current status of a modem, proceed as follows: 

 

Step Action 
1 

 

In the Management Tree, expand the 
Network element and click the modem you 
want (e.g. PTP slot 1). 

2 In the Management PtP Modem Properties window, click the  
button to view the current properties of the modem. 

Continued on next page 
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Monitoring the Modems, Continued 

  
Monitoring modem status (continued) 
 

Step Action 
3 At the upper-right part of the window, check if the modem is in 

standalone (None) or protection mode (Working or Protected). 

 
4 

 

In the Temperature group box, you can view 
the current temperature inside the modem 
(e.g. 38.3 ºC). 

5 In the Modem Version group box, you can see information about the 
version of the modem. 

6 In the Configuration group box, you can view the current channel 
bandwidth and profile of the modem.  
To modify the channel bandwidth, see par. Setting the Channel 
Bandwidth of a Link, on page 36. 

7 In the Modulation group box, you can view the modulation status of 
the modem.  
To modify the modulation status of the modem, see par. Enabling 
Adaptive Coding & Modulation (ACM), on page 39 and par. Setting 
Manual Modulation Mode, on page 42.  

8 In the Modem Status group box, you can see information about the 
current status of the modem (modulation, protection mode, etc.), and 
you can monitor the status of the displayed lock indicators and alarms 
as well. Further to this paragraph, the information concerning the 
Modem Status group box is described in detail. 

9 In case you want to reset or restart the selected modem, see par. 
Resetting/ Restarting a Modem, on page 176. 

 
End of procedure. 

Continued on next page 
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Monitoring the Modems, Continued 

  
Modem status 
properties 

The following tables describes the properties displayed in the Modem Status 
group box of the Management PtP Modem Properties window: 

  
Property Description 

Current Tx/ RX 
PHY Modulation 

Displays the current Tx/ Rx physical modulation mode and the 
channel bandwidth of the OmniBAS node. 

Transmit Symbol 
Rate 

Displays the transmit symbol rate for the incoming flow in bps. 

Received 
Normalized MSE 

Displays the received normalized MSE (Mean Square Error)  
in dB. 

LDPC Decodes 
Stress 

Displays the Low-Density Parity Check code (LDPC) encoding. 

Protection Mode Displays the protection status of the selected modem taking one 
of the following values:  
• None – The selected modem works in standalone mode  

(i.e. it is not protected by a redundant one). 
• Working –The selected modem works in protection mode and 

it is in working mode (i.e. it is protected by redundant one). 
• Protect – The selected modem works in protection mode and 

it is in standby mode. 

 
Modem status-
Lock Indicators 

The following table describes the lock indicators displayed in the Management 
PtP Modem Properties window: 

 

Lock Indicator Description 
Timing Indicates if the selected modem is locked or unlocked in the 

symbol timing of the received signal. 
Preamble Indicates if the selected modem has detected (Lock) or not 

(Unlock) the required distribution of preamble patterns in the 
received signal. 

LDPC Unlock Indicates if the LDPC decoder of the selected modem is locked 
or unlocked.  

Continued on next page 
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Monitoring the Modems, Continued 

  
Modem status-
Alarms 

The following table describes the alarms displayed in the Management PtP 
Modem Properties window: 

 

Alarm Description 
Modem Failure Through this alarm, you can check the modem connection status. 

When the corresponding “virtual” led is:  
• Red (ON) – There is no link communication with corresponding 

remote modem 
• Grey (OFF) – Link communication with corresponding remote 

modem is Ok 
Link Status Through this alarm, you can check the Rx link status. When the 

corresponding “virtual” led is:  
• Green – Rx link communication with the corresponding 

remote modem is Ok (Rx link is locked and it is Ok). 
• Yellow – Rx link is not locked yet 
• Red – Modem failure 

Link Error Through this field, you can view the type of the link error. 
Otherwise, it takes the No Error value. The possible link errors 
are the following: 
• Failed at AGC 
• Failed at Timing 
• Failed at Freq Sweep 
• MSE Error 
• Bit Error 
• Service Error 
• Failed at BLIND 
• Failed on Timeout 
• Stopped 
• Fatal Error 

 
End of procedure. 

 Continued on next page 
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Monitoring the Modems, Continued 

  
Identifying the 
remote modem 

When monitoring the status of a modem, you can also identify the 
corresponding modem of the remote station and the status of this link as well. 
To identify the remote modem related to a selected-local modem, proceed as 
follows: 

 
Step Action 

1 In the Management Tree, expand the 
Network element and click the modem of the 
local station you want (e.g. PTP slot 3 of 
192.168.57.12 OmniBAS). 

2 In the Management PtP Modem Properties window, click the  
button to view the current properties of the selected modem. 

 

Continued on next page 
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Monitoring the Modems, Continued 

  
Identifying the remote modem (continued) 
 

Step Action 
3 Through the Remote Modem group box, you 

can view: 
• The IP address of the corresponding remote 

modem and its current slot position (e.g. 
modem located in slot 3 of the 192.168.57.9 
OmniBAS node).  

 • The link status through the Link Status “virtual” led: 

When the Link Status 
“virtual” led is: 

Description 

Green Remote modem reception is Ok. 

Yellow Link communication is failed. Remote modem 
reception is not locked. 

Grey Link communication is failed. Remote modem 
status cannot be retrieved. 

 
 

 
End of procedure. 
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Monitoring the ODUs 
  

Introduction This paragraph describes how to monitor the current status, the radio and 
threshold alarms, the capabilities, the measurements and the version of an 
ODU.  
The monitoring of an ODU is performed through the PtP ODU Management 
Properties window (that appears when you select the ODU you want in the 
Management Tree).  

 
Monitoring 
ODU current 
status 

In the PtP -ODU Management Properties window, click the Status tab. In the 
Status tabbed sheet that appears, click the  button to update the 
displayed data. 

 
 

  Attribute Description 
Operation Status Displays the operation status of the ODU (Connected or 

Disconnected). 
Bandwidth Displays the current channel bandwidth (7 MHz,  

13.75/ 14 MHz, 27.5/ 28 MHz or 55/ 56 MHz) of the ODU. 
Current Tx Frequency Displays the current operating Tx frequency 

Continued on next page 
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Monitoring the ODUs, Continued 

  
Monitoring ODU current status (continued) 

 
  Attribute Description 

Current Rx 
Frequency 

Displays the current operating Rx frequency 

Current Tx Power Displays the current power transmitted from the ODU (in 
dBm) 

Mute Indicates the mute status of the ODU (mute/ ON, unmute/ 
OFF) 

DC Power Indicates if the DC power of the ODU is powered down 
(OFF) or not (ON). 

Update Status Indicates the current firmware status of the ODU. The 
following messages can be displayed: 
• Updated – The firmware status of the ODU is OK (the 

ODU is updated with the latest firmware). 
• Needs Update – The firmware of the ODU should be 

updated. The ODU’s firmware is updated either 
automatically or manually(1). 

• Updated Now – The ODU’s firmware upgrading 
process is taking place. 

Continued on next page 

                                                 
(1)  See par. Configuring an ODU, on page 30. 
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Monitoring the ODUs, Continued 

 
Monitoring 
radio alarms 

In the PtP -ODU Management Properties window, click the Status tab. In the 
Status tabbed sheet that appears, click the  button to retrieve the 
current information regarding the radio alarms of the selected ODU. 

 
The following table describes when the threshold alarms are generated. When 
an alarm is generated, the corresponding “virtual” led is red. 

 
Radio Alarm Alarm Generation 

RSSI (Rx Power 
Alarm) 

When the power from the remote radio unit (Rx power) is 
less than the factory pre-defined value. 
When the output power is 3 dB less than the desired Tx 
Power value (defined by the user in the Configuration 
tabbed sheet). 

ALC (Tx Power 
Alarm) 

NOTE  
In case the desired Tx Power value is greater than 
the current Max Tx Power(1), the ALC alarm is 
generated when the output power is 3 dB less than 
the current Max Tx Power value. 

Rx PLL Unlocked When the receiver’s PLL synthesizer is unlocked. 
Tx PLL Unlocked When the transmitter’s PLL synthesizer is unlocked. 
MW PLL Unlocked When the fractional PLL synthesizer is unlocked. 
LB PLL Unlocked When the loopback synthesizer is activated and unlocked. 
Freq. out of range 
errors 

When the frequency of the ODU transmission radio band is 
out of supported range or it is not an integer multiple of 
supported frequency step. 
The supported range of the ODU Tx frequency and the 
frequency step are shown in the Capabilities tabbed sheet. 

Power out of range 
errors 

The Tx power of the ODU is out of dynamically estimated 
supported range. 
The supported range of the ODU output power is shown in 
the Capabilities tabbed sheet. 

Continued on next page 

                                                 
(1)  The current Max Tx Power is displayed in the Capabilities tabbed sheet. 
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Monitoring the ODUs, Continued 

 
Monitoring 
ODU threshold 
alarms 

In the PtP -ODU Management Properties window, click the Status tab. In the 
Status tabbed sheet that appears, click the  button to retrieve the 
current information regarding the threshold alarms of the selected ODU. 

 
The following table describes when the threshold alarms are generated. 
When an alarm is generated, the corresponding “virtual” led is red. 

 
Alarm Alarm Generation 

Max 
Temperature 

When the temperature inside the ODU exceeds the threshold 
you have set (see par. Configuring an ODU, on page 30.). 

RSSI 
Threshold 

When Rx power (i.e. power from the remote radio unit) is less 
than the threshold defined by the user (see par. Configuring an 
ODU, on page 30.). 

Pif (If Power 
Alarm) 

When the power of the Tx IF signal falls below -26.5 dBm. 

Below +5 V When the output voltage of the ODU internal power supply unit 
falls below +4.85 V. 

Below +6.5 V When the output voltage of the ODU internal power supply unit 
falls below +6.35 V. 

Continued on next page 
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Monitoring the ODUs, Continued 

  
Monitoring ODU 
capabilities 

In the PtP -ODU Management Properties window, click the Capabilities tab. 
In the Capabilities tabbed sheet that appears, click the  button to 
retrieve the current information regarding the capabilities of the selected 
ODU. 

 
  

Attribute Description 
Band Displays the transmission radio band of the ODU (High or 

Low). 
Spectrum 
Inversion 

Indicates if spectrum inversion is enabled (ON) or not (OFF). 

Loopback SI Indicates if the ODU loopback capability is supported (ON) or 
not (OFF). 

First Frequency Displays the first frequency of the ODU transmission radio 
band (in kHz). 

Last Frequency Displays the last frequency of the ODU transmission radio 
band (in kHz). 

Frequency Step Displays the frequency step used for frequency channel 
selection. 

Max Tx Power Displays the upper limit of the power allowed for specific 
modulation (in dBm). 

Min Tx Power Displays the lower limit of the power allowed (in dBm). 

Continued on next page 
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Monitoring the ODUs, Continued 

  
Monitoring 
ODU 
measurements 

In the PtP -ODU Management Properties window, click the Analogue Monitor 
tab. In the Analogue Monitor tabbed sheet that appears, click the  
button to retrieve the current measurements regarding the selected ODU. 

 
  

Attribute Description 
Temperature Displays the temperature inside the ODU (in ºC). 
RSSI Displays the ODU reception level (in dBm). 
Pif Displays the power of the Tx IF signal from the indoor 

equipment (OmniBAS-4W subrack) (in dBm). 
Power Output Volt 
Detector 

Displays the power at the ODU output i.e. the 
transmission power (in dBm). 

+6,5 V, +5 V, - 5 V Displays the output voltages of the ODU’s internal power 
supply units. 

Continued on next page 
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Monitoring the ODUs, Continued 

 
Monitoring 
ODU version 

In the PtP -ODU Management Properties window, click the Version tab. In 
the Version tabbed sheet that appears, click the  button to retrieve the 
current information regarding the version of the selected ODU. 

 
  

Attribute Description 
Model Type Displays the model type of the ODU. 
Serial Number Displays the S/N of the ODU. 
ID Displays the identification number of the ODU. 
Software Version Displays the firmware version of the ODU. 
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5 Viewing Lists 
  

 This chapter describes how to retrieve details concerning the alarms, the 
SNMP messages and the PWE3 TDM connections through the corresponding 
lists of the OmniLCT application. The chapter also provides step-by-step 
procedures to remove OmniBAS entities (PWE3 TDM connections, VLANs, 
VLAN ports). 
The chapter contains the following topics: 
• Alarms & Events Report 
• Message Traces 
• Connections List 
• VLAN List 
• VLAN Port Membership List 
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Alarms & Events Report 
 

Introduction By default, the OmniLCT application performs tracking and recording of the 
various alarms and events related to the connected OmniBAS nodes. This 
paragraph describes how to retrieve the alarms and events list of the 
connected OmniBAS nodes. 

  
Alarms & Events 
Report window 

To view the alarms and events report, select Tools > Alarm & Event List on 
the Main Menu (or click , on the Toolbar). 
In the Alarms & Events Report window that appears, you can see details 
about tracked system alarms and events, together with their current status. 

 
  

NOTE  
By default, the maximum number of the logged alarms/ events (rows) 
displayed in the Alarms & Events Report window is 5000. When this 
number is reached, the list is cleared and new alarms/ events can be 
logged. To re-define the list bound, see par. Configuring the Application’s 
Environment (page 21). 

Continued on next page 



OmniBAS LCT  
User Manual - Edition 1.0 

Chapter 5. Viewing Lists 

 

132 

 

Alarms & Events Report, Continued 

 
Toolbar of 
Alarms & Events 
Report window 

The Alarms & Events Report window includes a toolbar through which you 
can perform the actions described in the following table: 

Button Description 

 To clear the list. 

 To save the list in a text file. 

 To print the list. 

 List scrolls automatically. 

 List stays always on top. 

 To search for specific text in the list, use the  
text box. After typing the text you want, click the  button.  

 
Also, you can press the “+”/ “-”keyboard’s keys to enlarge/ reduce the list’s 
font size. 
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Message Traces 
  

Introduction By default, the OmniLCT application provides a list with the current SNMP 
messages and errors related to the connected OmniBAS nodes. This 
paragraph describes how to retrieve the messages list. 

 
Message 
Traces window 

To view the Message Trace window, select View > Message Trace on the 
Main Menu. The Message Trace window displays the user requests and the 
application responses. 

  
NOTE  

By default, the maximum number of the logged messages (rows) 
displayed in the Message Trace window is 5000. When this number is 
reached, the list is cleared and new messages can be logged. To 
re-define the list bound, see par. see par. Configuring the Application’s 
Environment (page 21). 

 
Toolbar of 
Message 
Traces window 

The Message Trace window includes a toolbar through which you can 
perform the actions described in the following table: 

Button Description 

 To clear the list. 

 To save the list in a text file. 

 To print the list. 

 List scrolls automatically. 

 List stays always on top. 

 To search for specific text in the list, use the  
text box. After typing the text you want, click the  button. 

 To view details concerning the packets exchanged between the 
OmniLCT and the SNMP agent.  

 
Also, you can press the “+”/ “-”keyboard’s keys to enlarge/ reduce the list’s 
font size. 
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Connections List 
 

Introduction This paragraph describes the Connections List window, through which you can 
view the PWE3 TDM connections of the OmniBAS node together with their 
attributes. Also, this paragraph describes how to: 
• Activate the Connections List window. 
• Remove PWE3 TDM connections from the OmniBAS node  

 

NOTE

 

Through the Connections List window, you can also monitor the 
performance of the PWE3 TDM connections, as described in par. 
Monitoring the Performance of a PWE3 TDM Connection, on page 158. 

 
Activating 
Connections 
List 

To activate the Connections List window of an OmniBAS node, proceed as 
follows: 
 

Step Action 
1 

 

In the Management Tree, click on 
the OmniBAS node you want. 

2 On the Main Menu, select Tools > Connection List (or click 
 

 

on the Toolbar). 

3 The Connections List window of the selected OmniBAS node 
appears: 

4 On the toolbar of the Connections List window, expand the  
 button and click PWE3 TDM.  

Continued on next page 
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Connections List, Continued 

 
Activating 
Connections 
List (continued) 

 

Step Action 
5 The created PWE3 TDM connections of the OmniBAS node are 

displayed together with their attributes. 

 
Further to this paragraph, the attributes description of the PWE3 
TDM connections, as well as, the Toolbar description of the 
Connections List window, is provided. 

 

End of procedure. 

 
Removing 
connections 

To remove connections from an OmniBAS node, proceed as follows: 
 

Step Action 
1 Activate the Connections List window of the OmniBAS node, as 

described in the previous par. Activating Connections List. 
2 In the Connections List window select the connection you want, 

click the right mouse button and from the drop-down menu that 
appears, select: 
• Delete, to delete the selected connection 
• Delete All, to delete all created connections 

 
The selected PWE3 connection(s) are removed from the OmniBAS 
node. 

  
End of procedure. 

Continued on next page 



OmniBAS LCT  
User Manual - Edition 1.0 

Chapter 5. Viewing Lists 

 

136 

 

Connections List, Continued 

 
Attributes 
description 

The following table describes the attributes of the PWE3 connections displayed 
in the Connections List window: 
 

Attribute Description 
ECID 
Ingress 

Ingress Emulated Circuit Identifier for the L2 port side of the 
PWE3 TDM connection. (Value range: 1 to 65535) 

ECID Egress Egress Emulated Circuit Identifier for the L2 port side of the 
PWE3 TDM connection. (Value range: 1 to 65535) 

Port ID Indicates the E1 line associated with the PWE3 TDM connection. 
No of TS Indicates the number of timeslots associated with the PWE3 

connection. This number is equal to 32, as all timeslots of the E1 
line are used for the creation of the PWE3 TDM connection. 

L2 Port Indicates the L2 port associated with the PWE3 TDM connection. 
The L2 ports with index 1 and 2 correspond to GbE Port 1 and 
GbE Port 2, respectively.  
The L2 ports with index 3 to 6 correspond to the modems L2 
ports, as follows: 
− L2 port with index 3 corresponds to modem-PTP slot 1  
− L2 port with index 4 corresponds to modem-PTP slot 2  
− L2 port with index 5 corresponds to modem-PTP slot 3 
− L2 port with index 6 corresponds to modem-PTP slot 4 

Dest. MAC 
Address 

MAC address of the tributary module on which the created PWE3 
TDM connection terminates. 

VLAN Exist Indicates if the L2 port is associated (Yes) or not (No) with a 
VLAN. 

VLAN ID Indicates the VLAN ID (if a VLAN is associated with the L2 port). 
VLAN Pri. 
Bits 

Indicates the VLAN Priority Bits (802.1p priority bit) and takes 
values from 0 to 7 (7 is the highest priority, 0 is the lowest 
priority). 

Payload 
Suppress 

When taking value: 
• Yes: No packets are transmitted when the source E1 has 

nothing to send (all zeros). 
• No: All packets are thransmitted 

Buf E1 
Frames 

Indicates the number of Buffered E1 Frames. This attribute is 
used for the calculation of the PSN packet size(1).  
By default, the value is 8. (Value Range: 1 to 255). 

Packet Jitter Refers to the latency of the packets. By default, the value is 
10000. (Value range: 250 μsec to 30000 μsec).  

Oper Status Indicates the operational status of the connection and takes only 
the Enabled value. 

Continued on next page 

                                                 
(1)  PSN packet size = (Buffered E1 frames) x (nSlots), where nSlots = 32 in unstructured mode. 
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Connections List, Continued 

 
Toolbar The Connections List window includes a toolbar through which you can 

perform the actions described in the following table: 

Button Description 

 To retrieve the list of the created PWE3 TDM connections. 

 To delete the selected connection(s).  

 To cancel a request. 

 To open the Connection Setup Wizard. 
(See also par. 3.3 Configuring PWE3 TDM Connections, on  
page 70). 

 To search for specific text in the list, use the  
text box. After typing the text you want, click the  button. 

 Connections list stays always on top. 

 To save the connections list in a text file. 
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VLAN List 
 

Introduction This paragraph describes the VLAN List window, through which you can: 
• View the created VLANs of an OmniBAS node 
• Delete a VLAN (or all VLANs) 
• Select a VLAN 

 
Viewing VLAN 
List 

To view the VLAN List window, proceed as follows: 

 
Step Action 

1 In the Management Tree, expand the 
OmniBAS node you want and select 
the Control element. 

2 In the Management Control Properties window that appears, click 
the  button (located in the System group box).  

 
3 In the VLAN tabbed sheet of the L2 Properties window that 

appears, click the  button. 

 

Continued on next page 
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VLAN List, Continued 

  
Viewing VLAN List (continued) 

 

Step Action 
4 The VLAN List window appears. Click the  button to display 

the list of the created VLANs. 

 
The VLAN column displays the ID of all created VLANs. Also, you 
can identify the management VLAN (Mng VLAN – VLAN with ID=1 
is used by default as the management VLAN). 

 

End of procedure. 

 
Removing 
VLAN(s) 

To remove a VLAN, proceed as follows: 
 

Step Action 
1 Activate the VLAN List window of the OmniBAS node, as 

described in the previous par. Viewing VLAN List. 
 NOTE  

Prior to removing a VLAN, ensure that no L2 port is 
already associated with this specific VLAN. 

2 In the VLAN List window select the VLAN you want, click the right 
mouse button and from the drop-down menu that appears, select: 

 

 

• Delete Selected, 
to delete the 
selected VLAN 

• Delete All, to 
delete all created 
VLANs 

 The selected VLAN(s) are removed from the OmniBAS node. 
  
End of procedure. 

Continued on next page 
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VLAN List, Continued 

 
Selecting a 
VLAN 

The procedure provided below, describes how to select a VLAN from the 
VLAN List window. 
The selection of a VLAN could be needed, when: 
• Creating VLANs 

 
• Setting L2 Ports 

 
• Setting L2 Bridging 

Mode 

 
• Associating VLANs 

with L2 Ports 

  

Continued on next page 
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VLAN List, Continued 

 
Selecting a 
VLAN 
(continued) 

Tο select a VLAN, proceed as follows:  
 

Step Action 
1 Activate the VLAN List window (through the corresponding 

buttons (  or ) shown in the above screens). 
2 In the VLAN List window, select the VLAN you want (e.g.  

VLAN ID=3), click the right mouse button and from the drop-down 
menu that appears, select the Select VLAN option. 

 
3 

 

The selected VLAN 
is displayed in the 
corresponding 
window (e.g. in the 
VLAN tabbed 
sheet). 

  
End of procedure. 

 
Toolbar The VLAN List window includes a toolbar through which you can perform the 

actions described in the following table: 

Button Description 

 To retrieve the list of the created VLANs. 

 To cancel a request. 

 To clear the VLAN list. 

 To save the VLAN list in a text file. 
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VLAN Port Membership List 
 

Introduction This paragraph describes how to remove VLAN ports. A VLAN port is defined 
as the association between an L2 port and the corresponding VLAN. 

 
NOTE  

To view the list providing the current associations of the VLANs 
with the L2 ports, see par. Viewing the VLAN Port Membership 
List, on page 56). 

  
Removing 
VLAN ports 

To remove VLAN port(s), proceed as follows: 

 
Step Action 

1 

 

In the Management Tree, expand the 
OmniBAS node you want and select 
the Control element. 

2 In the Management Control Properties window that appears, click 
the  button (located in the System group box).  

 
3 In the VLAN Port tabbed sheet of the L2 Properties window that 

appears, click the  button. 

 

Continued on next page 
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VLAN Port Membership List, Continued 

  
Removing VLAN ports (continued) 
 

Step Action 
4 In the VLAN Port Membership List window, click the  button to 

display the list of all associations between L2 ports and VLANs. 

 
5 In the VLAN Port Membership List window, click the row 

corresponding to the association you want to remove (e.g. GbE1 Port 
with VLAN ID = 30). 

 
6 Click the right mouse button and from the drop-down menu: 

• Select the Delete Selected option. The selected association (e.g. 
Modem 1 Port with VLAN ID = 100) is removed. 

• Select the Delete All option to remove all VLAN ports. 
 

End of procedure. 
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6 Monitoring the Performance of an OmniBAS Node 
  

 This chapter describes how to monitor the performance of an OmniBAS node. 
The chapter includes the following topics: 
• Monitoring Ethernet Traffic through Wireline L2 Ports (GbE) 
• Monitoring Ethernet Traffic through Wireless L2 Ports (Modem) 
• Monitoring the Performance of a Modem 
• Monitoring the Performance of a PWE3 TDM Connection 
• Monitoring the L2 Ports Performance 
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 Monitoring Ethernet Traffic through Wireline L2 Ports (GbE) 
   

Introduction This paragraph describes how to monitor the Ethernet traffic conveying 
through the GbE ports of an OmniBAS node. 

  
Monitoring GbE 
ports 
performance 

To monitor the Ethernet traffic conveying through the GbE ports of an 
OmniBAS node, proceed as follows: 
 

Step Action 
1 

 

In the Management Tree, click the 
OmniBAS node you want (e.g. 
192.168.57.11 OmniBAS). 

 

2 On the Main Menu, select Windows > Performance Monitor (or 
 click , on the Toolbar). 

3 In the Performance Monitor window that appears, click the GbE 
tab. The GbE Performance tabbed sheet appears displaying the 
GbE counters for the two GbE ports of the OmniBAS-4W subrack. 

 

Continued on next page 
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Monitoring Ethernet Traffic through Wireline L2 Ports (GbE), 
Continued 

 
Monitoring GbE 
ports 
performance 
(continued) 

 

Step Action 
4 On the Toolbar of the Performance Monitor window, click the 

 button to see the statistics for both GbE ports for a time 
period between the completion of the last 15 min interval until the 
current time (1).  

 
NOTE  

See Appendix A – Statistic Counters Description for the 
description of the counters displayed in the GbE 
Performance tabbed sheet. 

 

Continued on next page 

                                                 
(1)  e.g. If the time is 12.26 pm and you click the  button, you will see the performance for the eleven 
min between 12.15 pm and 12.26 pm. If the time is 12.35 pm and you click the  button, you will see 
the performance for the five minutes between 12.30 pm and 12.35 pm. 
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Monitoring Ethernet Traffic through Wireline L2 Ports (GbE), 
Continued 

 
Monitoring GbE 
ports 
performance 
(continued) 

 

Step Action 
5 In case you want to:  

• Reset the collected statistics concerning the Ethernet traffic 

conveying through the GbE ports, click the  button of 
the GbE Performance tabbed sheet (at the bottom-right side of 
the Performance Monitor window). 

• Reset all the collected statistics concerning the selected 

OmniBAS node, click the  button in the toolbar of the 
Performance Monitor window. 

• Save all the collected statistics concerning the selected 

OmniBAS node in a text file, click the  button in the 
toolbar of the Performance Monitor window. 

 
End of procedure. 

Continued on next page 
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Monitoring Ethernet Traffic through Wireline L2 Ports (GbE), 
Continued 

 
Monitoring GbE 
errors counters 

 

Step Action 
1 In the Management Tree, click the 

OmniBAS node you want (e.g. 
192.168.57.11 OmniBAS). 

 

2 On the Main Menu, select Windows > Performance Monitor (or 
 click , on the Toolbar). 

3 If you want to view the GbE error counters, click GbE Errors tab 
in the Performance Monitor window. 
The GbE Performance Errors tabbed sheet appears displaying the 
GbE error counter for the two GbE ports of the OmniBAS-4W 
subrack. 

 

Continued on next page 
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Monitoring Ethernet Traffic through Wireline L2 Ports (GbE), 
Continued 

 
Monitoring GbE 
errors counters 
(continued) 

 

Step Action 
4 • On the Toolbar of the Performance Monitor window, click the 

 button to see the error counters for both GbE ports for a 
time period between the completion of the last 15 min interval 
until the current time.  

• In case you want to: 
− Reset the collected statistics concerning the GbE error 

counters, click the  button of the GbE Performance 
Errors tabbed sheet (at the bottom-right side of the 
Performance Monitor window). 

− Reset all the collected statistics concerning the selected 

OmniBAS node, click the  button in the toolbar of 
the Performance Monitor window. 

− Save all the collected statistics concerning the selected 

OmniBAS node in a text file, click the  button in the 
toolbar of the Performance Monitor window. 

 
NOTE  

See Appendix A – Statistic Counters Description for 
the description of the counters displayed in the GbE 
Performance Errors tabbed sheet. 

 
End of procedure. 
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Monitoring Ethernet Traffic through Wireless L2 Ports (Modem) 
   

Introduction This paragraph describes how to monitor the Ethernet traffic conveying 
through a wireless L2 port (i.e. a modem) of an OmniBAS node. 

  
Monitoring ETH 
traffic (Tx/ Rx 
counters) 

To monitor the Ethernet traffic (Tx/ Rx counters) conveying through a modem 
of an OmniBAS node, proceed as follows:  

 
Step Action 

1 

 

In the Management Tree, expand the 
OmniBAS node and select the 
modem you want (e.g. PTP slot 3 of 
192.168.57.8 OmniBAS). 

 

2 On the Main Menu, select Windows > Performance Monitor (or 
 click , on the Toolbar). 

3 In the Performance Monitor window that appears, click the PtP 
Ethernet tab and then click: 
• Tx Counters tab to monitor the Tx Ethernet traffic 
• Rx Counters tab to monitor the Rx Ethernet traffic 

Continued on next page 
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Monitoring Ethernet Traffic through Wireless L2 Ports (Modem), 
Continued 

  
Monitoring ETH traffic (Tx/ Rx counters) (continued) 
 

Step Action 
4 On the Toolbar of the Performance Monitor window, click the  

button to see the statistics for the received Ethernet traffic (through 
Rx Counters tabbed sheet) or for the transmitted Ethernet traffic 
(through Tx Counters tabbed sheet) for a time period between the 
completion of the last 15 min interval until the current time (1).  

Continued on next page 

                                                 
(1)  e.g. If the time is 12.26 pm and you click the  button, you will see the performance for the eleven 
min between 12.15 pm and 12.26 pm. If the time is 12.35 pm and you click the  button, you will see 
the performance for the five minutes between 12.30 pm and 12.35 pm. 
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Monitoring Ethernet Traffic through Wireless L2 Ports (Modem), 
Continued 

  
Monitoring ETH traffic (Tx/ Rx counters) (continued) 

 
Step Action 

5 From the Cumulative Control drop-down list, select: 
• On, in case you want to collect Ethernet statistics over time 
• Off, in case you want to collect real-time Ethernet statistics 

6 In case you want to:  
• Reset the collected statistics concerning the Ethernet traffic 

conveying through the selected modem, click the  button 
of the PTP Modem Ethernet Performance Counters tabbed sheet 
(at the bottom-right side of the Performance Monitor window). 

• Reset all the collected statistics concerning the selected OmniBAS 

node, click the  button in the toolbar of the Performance 
Monitor window. 

• Save all the collected statistics concerning the selected OmniBAS 

node in a text file, click the  button in the toolbar of the 
Performance Monitor window. 

 

NOTE  
See Appendix A – Statistic Counters Description for the description 
of the counters displayed in the PTP Modem Ethernet Performance 
Counters tabbed sheets. 

 
End of procedure. 

Continued on next page 
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Monitoring Ethernet Traffic through Wireless L2 Ports (Modem), 
Continued 

  
Monitoring/ 
Setting byte rate 
of ETH traffic 

To monitor the bytes rate of the Ethernet traffic conveying through a modem of 
an OmniBAS node, proceed as follows:  

 
 Step Action 

1 In the Management Tree, expand the 
OmniBAS node and select the modem 
you want (e.g. PTP slot 3 of 
192.168.57.8 OmniBAS). 

 

2 On the Main Menu, select Windows > Performance Monitor (or 
 click 

 
, on the Toolbar). 

3 

 

In the Performance 
Monitor window that 
appears, click the 
PtP Ethernet tab 
and then click the 
Rate tab. 

Continued on next page 
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Monitoring Ethernet Traffic through Wireless L2 Ports (Modem), 
Continued 

  
Monitoring/ Setting byte rate of ETH traffic (continued) 

 
Step Action 

4 In the Rate tabbed sheet, click the  button to retrieve the 
bytes rate transmitted/ received by the modem. 

 
If you want to change the rate time, type the new one (in sec) to the 
Rate Time text box and click the  button. 
For example, if 1 sec is set as rate time, the Tx Byte Rate (or Rx 
Byte Rate) field displays the bytes per second transmitted (or 
received) by the modem. 

5 In case you want to:  
• Reset all the collected statistics concerning the selected 

OmniBAS node, click the  button in the toolbar of the 
Performance Monitor window. 

• Save all the collected statistics concerning the selected OmniBAS 

node in a text file, click the  button in the toolbar of the 
Performance Monitor window. 

 
End of procedure. 
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Monitoring the Performance of a Modem 
   

Introduction This paragraph describes how to monitor the performance of an OmniBAS 
node modem. 

  
Monitoring 
modem 
performance 

To monitor the performance of a modem for a specific OmniBAS node, 
proceed as follows:  

 
Step Action 

1 

 

In the Management Tree, expand the 
OmniBAS node and select the 
modem you want (e.g. PTP slot 3 of 
192.168.57.8 OmniBAS). 

 

2 On the Main Menu, select Windows > Performance Monitor (or 
 click 

 
, on the Toolbar). 

3 In the Performance Monitor window that appears, click the PtP tab. 
The PTP Modem Performance Counters tabbed sheet appears: 

Continued on next page 
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Monitoring the Performance of a Modem, Continued 

  
Monitoring modem performance (continued) 
 

Step Action 
4 On the Toolbar of the Performance Monitor window, click the  

button to see the statistics for the selected modem for a time period 
between the completion of the last 15 min interval until the current 
time(1).  

Through the PTP Modem Performance Counters tabbed sheet, you 
can monitor: 
• Seconds In Phy X (2): The total time (in sec) that the Physical 

Modulation Profile X has been used by the selected modem. 
• Seconds Out Of Services: The total time (in sec) that the selected 

modem is out of service. 
• Seconds In Service: The total time (in sec) that the selected modem 

is in service. 
• Number Of Phy Changes: The number of times the Physical 

Modulation Profile of the modem has been change. 

Continued on next page 

                                                 
(1)  e.g. If the time is 12.26 pm and you click the  button, you will see the performance for the eleven 
min between 12.15 pm and 12.26 pm. If the time is 12.35 pm and you click the  button, you will see 
the performance for the five minutes between 12.30 pm and 12.35 pm. 
(2)  Where X = 1, 2, …, 16. Also, for more information about the Physical Modulation Profiles, see par. 
Setting manual modulation mode, on page 43. 
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Monitoring the Performance of a Modem, Continued 

  
Monitoring modem performance (continued) 

 
Step Action 

5 In case you want to:  
• Reset the collected statistics concerning the performance of the 

selected modem, click the  button of the PTP Modem 
Performance Counters tabbed sheet (at the bottom-right side of the 
Performance Monitor window). 

• Reset all the collected statistics concerning the selected OmniBAS 

node, click the  button in the toolbar of the Performance 
Monitor window. 

• Save all the collected statistics concerning the selected OmniBAS 

node in a text file, click the  button in the toolbar of the 
Performance Monitor window. 

 

End of procedure. 
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Monitoring the Performance of a PWE3 TDM Connection 
 

Introduction This paragraph describes how to monitor the performance for a PWE3 TDM 
connection of an OmniBAS node. 

  
Monitoring the 
performance of 
a PWE3 TDM 
connection  

To monitor the performance for a PWE3 TDM connection of an OmniBAS 
node, proceed as follows:  

 
Step Action 

1 In the Management Tree, click the 
OmniBAS node you want (e.g. 
192.168.57.8 OmniBAS). 

 

2 On the Main Menu, select Tools > Connection List (or click 
 , on the Toolbar)(1). 

3 On the toolbar of the Connections List window that appears expand 
the   button and click PWE3 TDM. The PWE3 TDM 
connections associated with the selected OmniBAS node appear. 

Continued on next page 

                                                 
(1)  Alternatively, you can open the Performance Monitor window (by selecting Windows > Performance 
Monitor on the Main Menu) and click the  button. 
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Monitoring the Performance of a PWE3 TDM Connection, 
Continued 

  
Monitoring the performance of a PWE3 TDM connection (continued) 
 

Step Action 
4 Click the row corresponding to the PWE3 TDM connection you want 

to monitor and click the right mouse button. From the drop-down 
menu select the Performance option. 

5 The Performance Monitor window appears with the PWE3 tab 
selected: 

Continued on next page 
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Monitoring the Performance of a PWE3 TDM Connection, 
Continued 

  
Monitoring the performance of a PWE3 TDM connection (continued) 
 

Step Action 
6 On the Toolbar of the Performance Monitor window, click the  

button to see the statistics for the selected PWE3 TDM connection for 
a time period between the completion of the last 15 min interval until 
the current time(1).  

Continued on next page 

                                                 
(1)  e.g. If the time is 12.26 pm and you click the  button, you will see the performance for the eleven 

min between 12.15 pm and 12.26 pm. If the time is 12.35 pm and you click the  button, you will 
see the performance for the five minutes between 12.30 pm and 12.35 pm. 
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Monitoring the Performance of a PWE3 TDM Connection, 
Continued 

  
Monitoring the performance of a PWE3 TDM connection (continued) 

 
Step Action 

7 In case you want to:  
• Reset the collected statistics concerning the performance of the 

selected PWE3 TDM connection, click the  button of the 
PWE3 Connections Statistics tabbed sheet (at the bottom-right side 
of the Performance Monitor window). 

• Reset all the collected statistics concerning the selected OmniBAS 

node, click the  button in the toolbar of the Performance 
Monitor window. 

• Save all the collected statistics concerning the selected OmniBAS 

node in a text file, click the  button in the toolbar of the 
Performance Monitor window. 

 
NOTE  

See Appendix A – Statistic Counters Description for the description 
of the counters displayed in the PWE3 Connections Statistics tabbed 
sheet. 

 
End of procedure. 
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Monitoring the L2 Ports Performance  
  

Introduction This paragraph describes how to monitor the performance of the L2 ports of 
an OmniBAS node. 

 
Monitoring L2 
ports 
performance 

To monitor the performance of an L2 port for a specific OmniBAS node, 
proceed as follows:  

 
Step Action 

1 

 

In the Management Tree, expand the 
OmniBAS node you want and select 
the Control element. 

2 In the Management Control Properties window that appears, click 
the  button (located in the System group box).  

 
3 In the L2 Properties window, click the L2 Port tab.  

In the L2 Port tabbed sheet, click  and/ or  
buttons to view the L2 bridge counters. 

Continued on next page 
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Monitoring the L2 Ports Performance, Continued 

  
Monitoring L2 ports performance (continued) 
 

Step Action 
4 In the L2 Port Statistic List 1 (or 2) window that appears, click the 

 button to display the statistics concerning the L2 ports of 
the selected OmniBAS node. 

5 If you want to reset the statistics of an L2 port, select the L2 port 
you want (e.g. Modem 1), click the right mouse button and from the 
drop-down menu select the Reset Selected L2 Port Stats option. 

In the same way, if you want to reset the counters of all L2 ports, 
select an L2 port, click the right mouse button and from the 
drop-down menu select the Reset All L2 Port Stats option. 

 
End of procedure. 
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7 Non-Routine Procedures 
 

 The following non-routine procedures mentioned in this chapter are carried 
out when required: 
• Performing Store, Backup or Restore Action 
• Resetting/ Restarting OmniBAS Node Modules 
• Clearing OmniBAS Node Configuration 
• Setting Inband Management / Changing Management VLAN 

 
 
7.1 Performing Store, Backup or Restore Action 

 
 This section describes how to perform the following actions: 

• Store: Saves the most current settings and configuration of an OmniBAS 
node to the OmniBAS-4W equipment. 

• Backup: Downloads the saved configuration files from the OmniBAS-4W 
equipment locally to your PC/ Laptop. 

• Restore: Uploads the configuration files from your PC/ Laptop to the 
OmniBAS-4W equipment. 
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Saving the Configuration of an OmniBAS Node 
 

Introduction This paragraph describes how to store the configuration of an OmniBAS 
node in the processor module of the OmniBAS-4W equipment. 

 
Saving OmniBAS 
configuration 

To save the configuration of an OmniBAS node, proceed as follows: 

 
Step Action 

1 

 

In the Management Tree, expand the 
OmniBAS node you want and select the 
Control element. 

2 In the Management Control Properties window that appears, click 
the  button to update the displayed data. 

 

Continued on next page 
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Saving the Configuration of an OmniBAS Node, Continued 

  
Saving OmniBAS configuration (continued) 

 
Step Action 

3 In the Actions group box, click the  button.  
In the confirmation message that appears click Yes to proceed. 
The settings and the configuration of the OmniBAS node is now 
saved. 

 
End of procedure. 
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Performing a Backup Action 
 

Introduction This paragraph describes how to download the most recent configuration files 
from the OmniBAS-4W equipment locally to your PC/ Laptop. 

 
Performing a 
backup action 

To perform a backup action, proceed as follows: 
 

Step Action 
1 

 

In the Management Tree, expand the 
OmniBAS node you want and select 
the Control element. 

2 In the Management Control Properties window that appears, click 
the  button to update the displayed data. 

 

Continued on next page 
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Performing a Backup Action, Continued 

 
Performing a 
backup action 
(continued) 

 

Step Action 
3 In the Actions group box, click the  button. The 

following window appears: 

 
4 In the Backup Configuration Files group box of the File 

Configuration tabbed sheet, click the button  and select the local 
directory to store the system configuration files. 

Continued on next page 
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Performing a Backup Action, Continued 

 
Performing a 
backup action 
(continued) 

 

Step Action 
5 Click the  button. The following message appears: 

 
Click Yes to start downloading the configuration files from the 
OmniBAS-4W equipment.  

 NOTE  
When performing a backup action, first, the system saves 
the most current settings and configuration of the 
OmniBAS node to the OmniBAS-4W equipment and then 
downloads the configuration files to your PC/ Laptop. 
Thus, it is not needed to save the configuration of an 
OmniBAS node (i.e. to click the  button) prior 
to performing a backup action. 

6 Wait until the “Backup Configuration Process Completed” message 
appears in the Messages area. 

 
 

End of procedure. 
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Performing a Restore Action 

 
Introduction This paragraph describes how to upload configuration files from your PC/ 

Laptop to the OmniBAS-4W equipment. 

 
Performing a 
restore action 

To perform a restore action, proceed as follows: 
 

Step Action 
1 

 

In the Management Tree, expand the 
OmniBAS node you want and select 
the Control element. 

2 In the Management Control Properties window that appears, click 
the  button to update the displayed data. 

 

Continued on next page 
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Performing a Restore Action, Continued 

 
Performing a 
restore action 
(continued) 

 

Step Action 
3 In the Actions group box, click the  button. The 

following window appears: 

 
4 In the Restore Configuration Files group box of the File 

Configuration tabbed sheet, click the button  and select the local 
directory where the system configuration files you want to upload 
are stored. 

5 Select the Reboot system after uploading check box for 
automatic system reboot after configuration uploading.  

 NOTE  
If you not select the Reboot system after uploading 
check box, you should reboot the system (by clicking the 

 button located in the System group box of the 
Management Control Properties window) at a convenient 
time for the uploaded configuration to take effect.  

Continued on next page 
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Performing a Restore Action, Continued 

 
Performing a 
restore action 
(continued) 

 

Step Action 
6 Click the  button. The following message appears: 

 
Click Yes to start uploading the configuration files to the 
OmniBAS-4W equipment. 

7 Wait until the “Restore Configuration Process Completed” message 
appears in the Messages area. 
The system reboots and the uploaded configuration takes effect (if 
the Reboot system after uploading check box is selected). 

 NOTE  
If you did not select the Reboot system after uploading 
check box, you should reboot the system (by clicking the 

 button located in the System group box of the 
Management Control Properties window) at a convenient 
time for the uploaded configuration to take effect. 

 

End of procedure. 
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7.2 Resetting/ Restarting OmniBAS Node Modules 
 

 This chapter described how to reset/ restart the elements of an OmniBAS 
node. The chapter contains the following topics: 
• Resetting Processor Module 
• Resetting/ Restarting a Modem 
• Restarting an ODU 
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Resetting Processor Module 
 

Introduction This paragraph describes how to perform a reset action to the processor 
module of an OmniBAS node, when needed. 
When a processor reset is performed, the configuration of the OmniBAS 
node is saved and the processor module reboots. 

 

 
It is strongly recommended to avoid performing the Reset 
action, because traffic loss will occur. 

 
Resetting 
processor module 

To reset the processor module of an OmniBAS node, proceed as follows: 

 
Step Action 

1 

 

In the Management Tree, expand the 
OmniBAS node you want and select the 
Control element. 

2 In the Management Control Properties window that appears, click 
the  button to view the current properties of the Control 
element.  

 

Continued on next page 
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Resetting Processor Module, Continued 

  
Resetting processor module (continued) 

 
Step Action 

3 In the System group box, click the  button.  
4 In the confirmation message that appears, click Yes to continue. 
5 Wait the reset process of the processor module to complete. 

 

End of procedure. 
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Resetting/ Restarting a Modem 
  

Introduction This paragraph describes how to reset or restart a modem, when needed.  
 

 
It is strongly recommended to avoid performing the Reset 
action. This process will cause link downtime. 

 

NOTE  
When resetting a modem that is protected, an automatic switching 
process is initiated. 

 

NOTE  
The restart action of a modem is mainly performed for debugging 
purposes.  

 
Restarting/ 
resetting a 
modem 

To restart or reset a modem, proceed as follows: 
 

Step Action 
1 

 

In the Management Tree, expand the 
Network element and click the modem 
you want (e.g. PTP slot 1). 

2 In the Management PtP Modem Properties window, click the 
 button to view the current properties of the modem. 

 

Continued on next page 
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Resetting/ Restarting a Modem, Continued 

 
Restarting/ 
resetting a 
modem 
(continued) 

 

Step Action 
3 To restart the modem, click the  button (located in the 

Modem Status group box). 
In the following confirmation message that appears, click Yes to 
continue: 

 
Wait for the modem restart process to complete. 

4 To reset the modem, click the  button (located in the 
Modulation group box). 
In the following confirmation message that appears, click Yes to 
continue: 

 
Wait for the modem reset process to complete. 

  
End of procedure. 
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Restarting an ODU 
 

Introduction This paragraph describes how to restart an ODU, when needed. 
 

 
It is strongly recommended to avoid performing the restart 
action. This process will cause link downtime. 

 
NOTE  

When restarting an ODU that is working, an automatic switching 
process is initiated. 

 
Restarting an 
ODU 

To restart the ODU of an OmniBAS node, proceed as follows: 

 
Step Action 

1 In the Management Tree, expand 
the Network element of the 
OmniBAS node (e.g. 183.168.57.8) 
and click the ODU you want. 

Continued on next page 
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Restarting an ODU, Continued 

  
Restarting an ODU (continued) 

 
Step Action 

2 In the PtP -ODU Management Properties window, ensure that the 
Configuration tab is displayed – if not, select it.  

In the Configuration tabbed sheet, click the  button to 
retrieve the current properties of the ODU. 

 
3 Click the  button to restart the selected ODU.  
4 In the following confirmation message that appears, click Yes to 

continue: 

 
Wait for the ODU restart process to complete and the 
communication between the ODU and the indoor equipment to be 
established. 

 

End of procedure. 
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7.3 Clearing OmniBAS Node Configuration 
 

Introduction This paragraph describes how to clear the whole configuration (Clear CFG) of 
an OmniBAS node.  

 

 

It is strongly recommended not to carry out the Clear CFG 
action, because: 
• The traffic is lost. 
• The inband management is lost. 
• The whole configuration of the OmniBAS node is cleared. 

 
Clearing 
system 
configuration 

To clear all configuration of an OmniBAS node, proceed as follows: 
 

Step Action 
1 In the Management Tree, expand the 

OmniBAS node you want and select the 
Control element. 

2 In the Management Control Properties window that appears, click 
the  button to update the displayed data. 

 

Continued on next page 
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Clearing OmniBAS Node Configuration, Continued 

 
Clearing 
system 
configuration 
(continued) 

 

Step Action 
3 In the Actions group box, click the  button.  

In case you want to proceed, click Yes in the confirmation 
message that appears. 
The whole configuration of the OmniBAS node is cleared (e.g. 
VLANs, connections, etc.) and the system reboots. 

  
End of procedure. 
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7.4 Setting Inband Management / Changing Management VLAN 
 

Introduction This paragraph describes how to: 
• Change the management VLAN of an OmniBAS node.  

By default, the VLAN with ID =1 is used for the management. 
• Set up the inband management connection of an OmniBAS node. 

 
Changing 
Management 
VLAN 

To change the management VLAN of an OmniBAS node, proceed as follows: 
 

Step Action 
1 

 

In the Management Tree, expand the 
OmniBAS node you want and select 
the Control element. 

2 In the Management Control Properties window that appears, click the 
 button (located in the System group box).  

 
3 In the L2 Properties window, click the Bridge tab to display the 

Bridge tabbed sheet and then, click the   button to retrieve 
the general bridge parameters. 

The Management VLAN field displays the current management 
VLAN. By default, the VLAN with ID =1 is used for the management.  

Continued on next page 
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Setting Inband Management / Changing Management VLAN, 
Continued 

 
Changing 
Management 
VLAN 
(continued) 

 

Step Action 
4 Click the  button (next to Management VLAN field). In the VLAN 

list window that appears, click the  button to display all 
created VLANs. 

5 Select the VLAN you want, click the right mouse button and from the 
drop-down menu that appears select the Select VLAN option. 

6 The selected VLAN ID is displayed in the Management VLAN field. 

7 Click the  button to apply the management VLAN change. 
 
End of procedure. 

Continued on next page 
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Setting Inband Management / Changing Management VLAN, 
Continued 

 
Setting up 
inband 
management 
connection 

To set up the inband management connection of an OmniBAS node, proceed 
as follows: 
 

Step Action 
1 

 

In the Management Tree, expand the 
OmniBAS node you want and select 
the Control element. 

2 In the Management Control Properties window that appears, click 
the  button (located in the System group box).  

 
3 In the L2 Properties window, click the Bridge tab to display the 

Bridge tabbed sheet and then, click the   button to retrieve 
the general bridge parameters. 

 
By default, the VLAN with ID =1 is the management VLAN of the 
OmniBAS node. If you want to change the management VLAN, see 
the previous par. Changing Management VLAN (page 182). 

4 In the Inband Mgm Address text box, type the IP address of the 
OmniBAS node. If unsure, contact your network administrator. 

Continued on next page 
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Setting Inband Management / Changing Management VLAN, 
Continued 

 
Setting up 
inband 
management 
connection 
(continued) 

 

Step Action 
5 In Inband Mgm Net Mask text boxes, type the Net Mask of the 

OmniBAS node. If unsure, contact your network administrator. 
6 Click the  button to apply the new inband settings. 

  
End of procedure. 
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Appendix A – Statistic Counters Description 
 

 This Appendix provides a short description of the statistic counters displayed 
in the Performance Monitor window. The Appendix includes the following 
topics: 
• Rx/ Tx Counters (GbE Ports) 
• Rx/ Tx Error-Counters (GbE Ports) 
• Tx Counters (Wireless L2 Ports) 
• Rx Counters (Wireless L2 Ports) 
• L2 Port Counters 
• PWE3 TDM Counters 
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Rx/ Tx Counters (GbE Ports) 
   

 The following table describes the statistic counters about data conveying through 
the GbE ports. These counters are displayed in the GbE Performance tabbed 
sheet(1): 

 
Counter Description 

Rx Bytes Total number of good or bad frames transmitted and received 
with size 128 to 255  bytes in length inclusive (excluding 
framing bits but including FCS bytes). 

Rx Packets Total number of the received packets including bad packets 
and all Unicast, Broadcast and Multicast packets. 

Rx Multicast Frames Total number of the multicast good frames with size 64 to 
1518 (non VLAN) bytes in length or 1522 (VLAN) bytes in 
length (excluding broadcast frames). 

Rx Broadcast Frames Total number of the broadcast good frames with size 64 to 
1518 (non VLAN) bytes in length or 1522 (VLAN) bytes in 
length (excluding multicast frames). 

Rx Undersize Frames Total number of the received frames that are less than 64 
bytes in length and with a valid FCS value. 

Rx Oversize Frames Total number of the received frames that exceed 1518 bytes 
(non VLAN) or 1522 bytes (VLAN) in length and contain a 
valid FCS value. 

Tx Bytes Total number of bytes that were put on the wire including 
fragments of frames that were involved with collisions. This 
count does not include preamble/SFD or jam bytes. 

Tx Packets Total number of the transmitted packets including bad 
packets, excessive deferred packets, excessive collision 
packets, late collision packets and all Unicast, Broadcast and 
Multicast packets.  

Tx Multicast Frames Total number of the transmitted multicast frames (excluding 
broadcast frames). 

Tx Broadcast Frames Total number of the transmitted broadcast frames (excluding 
multicast frames). 

Tx Undersize Frames Total number of the transmitted frames that are less than 64 
bytes in length and with a valid FCS value. 

Tx Oversize Frames Total number of the oversized transmitted frames with a valid 
FCS value. 

Ethernet Transmitter 
underun 

Total number of times that the Ethernet transmitter underun 
occurred. 

Buffer Overrun 
Discarded frames 

Total number of the received Ethernet frames discarded due 
to a receive buffer overrun event (no available buffers). 

Tx Frames Total number of complete good frames transmitted. 

   

                                                 
(1) Open the Performance Monitor window of an OmniBAS node, and click GbE tab > GbE 1/2 tab. 
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Rx/ Tx Error-Counters (GbE Ports) 
  

 The following table describes the error-statistic counters about data conveying 
through the GbE ports. These counters are displayed in the GbE Performance 
Errors tabbed sheet(1): 

 
Counter Description 

In Pause Frames Number of received Pause frames (i.e. control frames containing 
valid pause opcode(2)). Pause frames are used to pause the flow 
of traffic when traffic congestion occurs. 

Out Pause 
Frames 

Number of transmitted Pause frames (i.e. control frames 
containing valid pause opcode(2)). Pause frames are used to 
pause the flow of traffic when traffic congestion occurs. 

Out Pause 
Honored Frames 

Number of pause frames not transmitted. 

Alignment Errors Number of alignment errors for the received frames. An 
alignment error is caused when a received frame does not end 
on a byte boundary and the CRC does not match at the last byte 
boundary. 

FCS Errors Number of received valid size frames with FCS (Frame Check 
Sequence) error but no framing errors. 

Single Collision 
Frames 

Number of frames involved in a single collision but subsequently 
are transmitted successfully. 

Multiple Collision 
Frames 

Number of frames involved in more than one collision but 
subsequently are transmitted successfully. 

Deferred 
Transmissions 

Number of transmitted frames deferred for an excessive period 
of time. 

Late Collisions Number of late collisions(3) detected. 
Excessive 
Collisions 

Number of frames that, due to excessive collisions, are 
discarded. 

Carrier Sense 
Errors 

Number of frames transmitted with carrier sense errors. This 
normally occurs as a result of collisions. 

Frame Too Longs Number of received frames that exceed the maximum permitted 
frame size.  

Internal Mac 
receive Errors 

Number of received packets discarded because of MAC 
sub-layer error. 

Symbol Errors Number of symbols received but not correctly decoded. 

 

                                                 
(1)  Open the Performance Monitor window of an OmniBAS node, and click GbE Errors tab >  

GbE Errors 1/2 tab. 
(2)  Opcodes: Operational codes contained in MAC Control frames 
(3)  Normal collisions occur during the first 512 bits of frame transmission. If a collision occurs after 512 bit 

times, then it is considered an error and called a late collision. A late collision is a serious error, since it 
indicates a problem with the network system, and since it causes the frame being transmitted to be 
discarded. 
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Tx Counters (Wireless L2 Ports) 
  

 The following table describes the statistic counters about Ethernet traffic 
transmitted through the wireless L2 ports (PtP Modems). The Tx Ethernet 
counters are displayed in the PTP Modem Ethernet Performance Counters (Tx 
Counters) tabbed sheet(1): 

 

Counter Description 
Tx Packet Number of transmitted Ethernet frames. 
Tx VLAN Tags Number of transmitted VLAN-tagged frames. 
Tx Back 
Pressures Events 

Number of carrier-sense-method back-pressure previously applied. 

Tx Under Runs Number of frames not transmitted due to under-run errors. 
Tx Giants Number of frames discarded as they have length size greater than 

the Max Frame Size of 1518 bytes (excluding preamble). 
Tx Late Collisions Number of late collisions(2) detected. 
Tx Max Collisions Number of frames aborted after number of collisions exceeded the 

Retransmission Maximum parameter. 
Tx Excessive 
Defers 

Number of transmitted frames deferred for an excessive period of 
time. 

Tx Non Excessive 
Defers 

Number of frames successfully transmitted after transmission has 
been deferred at least once. 

Tx Length Check 
Errors 

Number of transmitted frames with length that does not match the 
actual data byte length. 

Tx Pause Frames Number of transmitted Pause frames (i.e. control frames containing 
valid pause opcode(3)). 

Tx Control 
Frames 

Number of transmitted Control frames (i.e. frames contain a valid 
hex 0x8808 value in the type field). 

Tx CRC Errors Number of transmitted frames with invalid CRC (Cyclic Redundancy 
Check) value. 

Tx Collisions Number of collisions the current frame incurred during transmission 
attempts. It applies to successfully transmitted packets. 

Tx Multicasts Number of transmitted multicast frames (i.e. frames including 
multicast destination address). 

Tx Broadcasts Number of transmitted broadcast frames (i.e. frames including 
broadcast destination address). 

Tx Wire Byte Number of transmitted bytes, counting also all bytes from collided 
attempts. 

Tx Byte Number of transmitted bytes, not counting collided bytes. 
Cumulative Time Time in sec that the current Tx Ethernet statistics collected. 

 

                                                 
(1) Open the Performance Monitor window of a modem, and click PtP Ethernet tab > Tx Counters tab. 
(2) Normal collisions occur during the first 512 bits of frame transmission. If a collision occurs after 512 bit 

times, then it is considered an error and called a late collision. A late collision is a serious error, since it 
indicates a problem with the network system, and since it causes the frame being transmitted to be 
discarded. 

(3)  Opcodes: Operational codes contained in MAC Control frames 
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Rx Counters (Wireless L2 Ports) 
   

 The following table describes the statistic counters about Ethernet traffic 
received by the wireless L2 ports (PtP Modems). The Rx Ethernet counters are 
displayed in the PTP Modem Ethernet Performance Counters (Rx Counters)  
tabbed sheet(1): 

 

Counter Description 
Rx Packet Number of received Ethernet frames. 
Rx CRC Errors Number of received frames with invalid CRC (Cyclic Redundancy 

Check) value. 
Rx Truncated 
Frames 

Number of truncated received frames. 

Rx Long Events Number of received overlong frames (i.e. frames having byte 
count greater than the maximum frame size). 

Rx VLAN Tags 
Detected 

Number of received VLAN-tagged frames. 

Rx Unsupported 
OpCodes 

Number of received frames recognized as control frames but 
contain unknown opcodes(2). 

Rx Pause 
Frames 

Number of received Pause frames (i.e. frames recognized as 
control frames containing valid pause opcode(2) and also have 
valid destination address). 

Rx Control 
Frames 

Number of received Control frames (i.e. frames contain a valid 
hex 0x8808 value in the type field). 

Rx Dribble 
Nibbles 

Number of received frames including dribble nibble (i.e. including 
extra 1 to 7 bits at the end of the frame). The extra bits are 
thrown away. 

Rx Broadcasts Number of received broadcast frames (i.e. frames including 
broadcast destination address). 

Rx Multicasts Number of received multicast frames (i.e. frames including 
multicast destination address). 

Rx Out Of Range 
Errors 

Number of received frames with length field that exceeds the 
1518 bytes. 

Rx Length Check 
Errors 

Number of received frames with length that does not match the 
actual data byte length. 

Rx Code Errors Number of received frames including one or more nibbles 
signalled as errors. 

Rx False Carrier 
Errors 

Number of false carrier events detected (i.e. a false carrier event 
detected after the last receive of a frame and it is not associated 
with this packet). 

Rx Dv Event Number of last received events that are too short to be valid 
packets. 

Rx Previous 
Packet Drop 

Number of packets dropped since the last receive. 

Rx Byte Number of received bytes, not counting collided bytes. 
Cumulative Time Time in sec that the current Rx Ethernet statistics collected. 

 

                                                 
(1) Open the Performance Monitor window of a modem, and click PtP Ethernet tab > Rx Counters tab. 
(2) Opcodes: Operational codes contained in MAC Control frames 
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L2 Port Counters 
  

L2 Port 
Statistics List 1   

The following table describes the statistic counters of the L2 ports. These 
counters are displayed in the L2 Port Statistics List 1 window(1): 

 
Counter Description 

RxValid Number of frames that passed all input filters. 
DiscVLAN Number of frames that were discarded by the VLAN acceptable 

filtering. 
DiscIngr Number of frames that were discarded by the ingress filtering. 
DiscBridge Number of frames that were discarded by the classifier (DFC 

deny). 
DiscUnkMACSa Number of frames that were discarded because their source 

MAC address was unknown. 
Deny MACSa Number of frames that were discarded because their source 

MAC address was denied 
Deny MACDa Number of frames that were discarded because their destination 

MAC address was denied. 
rxBcValid Number of broadcast valid packets were received 
rxMcValid Number of multicast valid packets were received 
ForwUc Number of unicast frames that were forwarded. 
ForwBc Number of broadcast frames that were forwarded. 
ForwMc Number of multicast frames that were forwarded. 
ProtErr Number of packets dropped due to protocol error. 

 
L2 Port 
Statistics List 2 

The following table describes the statistic counters of the L2 ports. These 
counters are displayed in the L2 Port Statistics List 2 window(1): 

 
Counter Description 

Forward Number of valid packets forwarded by L2 port. 
Fbp Drop Not used 
Mtu Drop Not used 
Ttl Drop Not used 
Tx Queue Drop Number of packets dropped due to a congestion in the transmit 

queue. 
Mpls Drop Not used 
Denied Not used 
Group Filtered Not used 
Forwarded Bytes Not used 

Continued on next page 

                                                 
(1) To open the L2 Port Statistics List 1or 2 window, see par. Monitoring the L2 Ports Performance, on 

page 162. 
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L2 Port Counters, Continued 

  
L2 Port Statistics List 2 (continued) 
 

Counter Description 
Gtp Bad Headers Not used 
Policer 
NonConforming 

Not used 
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PWE3 TDM Counters 
  

 The following table describes the statistic counters concerning a selected PWE3 
TDM connection. PWE3 TDM counters are displayed in the PWE3 
Connections Statistics tabbed sheet(1): 

 

Counter Description 
Trans Rx Errors Overrun Not used 
Trans Tx Errors Underrun Number of invalid buffers received from PSN side. 
Ingress Rx Empty Fbp Not used 
Ingress Rx Valid Packets Number of received (from TDM side) packets 

forwarded to PSN side. 
Tdm2Psn Forwarded Packets Number of successfully forwarded packets to PSN 

side. 
Tdm2Psn Fbp Drop Packets Not used 
Tdm2Psn Mtu Drop Packets Not used 
Tx Queue Drop Packets Number of packets dropped due to a congestion in 

the transmit queue on PSN side. 
Egress Tx Valid Packets Number of packets successfully transmitted to TDM 

side. 
Egress Tx Dummy Packets Not used 
Egress Tx Buffer Underrun Not used 
Egress Tx Underrun Data 
Unit 

Number of times that transmit underrun occurred 
due to no packets received from PSN side, so no 
Rx buffers available exist to handle the Tx requests 
to TDM side. 

Psn2Tdm Forwarded Packets Number of successfully forwarded packets to TDM 
side. 

Psn2Tdm Fbp Drop Packets How many times received packets were rejected 
due to no available buffers on TDM side. 

Psn2Tdm Out of Window 
Packets 

Not used 

Buffer Overrun Dropped 
Packets 

Not used 

Psn2Tdm Window Switchover Not used 
Psn2Tdm Buffer Overrun 
Events 

Not used 

Psn2Tdm Stray Packets Not used 
Psn2Tdm Malformed Packets Not used 
Psn2Tdm Cw AIS Drop 
Packets 

Not used 

Continued on next page 

                                                 
(1) Open the Performance Monitor window of a modem, click the PWE3 tab and then click the  
button. In the Connection List window that appears, select the PWE3 TDM connection you want. The 
corresponding statistic counters appear in the PWE3 Connections Statistics tabbed sheet. 
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PWE3 TDM Counters, Continued 

 
Counter Description 

Psn2Tdm Multiple Packets Not used 
Psn2Tdm Mpls Drop Packets Not used 
Psn2Tdm Denied Packets Not used 
Psn2Tdm Out of Sequence 
Packets  

Not used 

Psn2Tdm Out of  Band Cas 
Packets 

Not used 
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Appendix B – 802.1Q Ethernet Frame 
 

About Ethernet 
MAC frame 

According IEEE 802.1Q specification, the Ethernet MAC frames are tagged as 
the following schematic shows:  

Preamble

1 2 3 4 5 6 7 8

Destination MAC

1 2 3 4 5 6

Source MAC

1 2 3 4 5 6 1 2

ETH 
Type / 
Size

Payload

1 . . . . n 1 2 3 4

CRS/ FCS

Preamble

1 2 3 4 5 6 7 8

Destination MAC

1 2 3 4 5 6

Source MAC

1 2 3 4 5 6 1 2

Payload

1 . . . . n 1 2 3 4

CRS/ FCS
802.1q 
Header

TPID

1 2 3 4
PCP
CFI
VID

16 bits

TPID

3 bits 1bit 12 bits

VID

802.1q 
Header

1 byte

1 2 1 2

VID

ETH 
Type / 
Size

Untagged frame

Priority tagged frame(1)

(1) Tagged frame (when PCP=0)

 
About 802.1Q 
header 

• TPID (Tag Protocol Identifier) – Indicates that the frame is an IEEE 802.1Q 
tagged frame. This field is located at the same position as the ETH Type/Size 
field in untagged frames, and thus it is used to distinguish the frame from 
untagged frames. 

• PCP (Priority Code Point) – Refers to the IEEE 802.1p priority that indicates 
the frame priority level from 0 (lowest) to 7 (highest), allowing packets to be 
grouped into various classes of traffic (voice, video, data, etc). 

• CFI (Canonical Format Indicator) – Indicates whether the MAC address is in 
canonical (CFI=1) or non-canonical format (CFI=0). It is always set to zero(1) 
for Ethernet switches. 

• VID (VLAN ID) – Indicates the VLAN to which the frame belongs. It takes 
values from 1 to 4096. VID= 1, by default, is reserved for management. The 
frame does not belong to any VLAN, when VID=0 (in this case the 802.1Q tag 
specifies only a priority and is referred to as a priority tag). 

 

                                                 
(1)  CFI is used for compatibility reason between Ethernet type network and Token Ring type network. If a 
frame received at an Ethernet port has CFI=1, then that frame should not be forwarded as it is to an 
untagged port. 
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